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Introduction
IFC - Industry Foundation Classes - is a neutral file format that makes it possible to exchange 
information between different CAD systems and other systems in the building and facility 
management sectors. The IFC format is ISO-certified and can be integrated into any existing 
quality assurance polices your office may have. IFC is developed in part by buildingSMART 
(formerly the IAI - the International Alliance for Interoperability). Today there are over 600 
members in 17 chapters around the world.

For more information on buildingSMART, see the website.

GRAPHISOFT has played an active role within the buildingSMART organization since 1996 and 
supports the IFC standard, which enables ARCHICAD to communicate with other disciplines 
within the context of the building model, and to coordinate a building project entirely in 3D. The 
building model can also be exported back to literally hundreds of other systems that support IFC.

The list of registered IFC supporter applications (by functional category/design disciplines) is 
available here.

BIM, or “Building Information Modeling,” is one of the biggest advances in the building industry’s 
working methods since the introduction of CAD software. BIM is not synonymous with 3D 
projects. Three-dimensional geometric representation is only one part of the digital deliverables. 
A project includes non-graphical information, such as calculations that are used in surveying, 
facility management and energy calculation. A prerequisite for a successful BIM project is that 
intelligent information can be exchanged between different software and even operating 
systems, throughout the stages of the building process. This interoperability demands a neutral 
file format with an open standard that supports different systems. IFC is such a system, enabling 
us to synchronize building models between the disciplines much more easily.

With its user-friendly interface and wide latitude for customization, ARCHICAD enables users to 
communicate in an efficient way, to focus on the needed elements and to locate any errors in 
design development via IFC data exchange. This chapter has been created to provide ARCHICAD 
users an insight into the IFC standard and how it works in ARCHICAD.
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Model View Definitions
Industry Foundation Classes (IFC) are the open and neutral data format for OPEN BIM- and 
model-based interoperability among design participants/disciplines. ARCHICAD supports the 
import and export of both IFC2x3 and IFC4 release. IFC data are managed according to the latest 
worldwide-certified IFC standard, IFC2x3 TC1 (Technical Corrigendum 1).

An IFC View Definition, or Model View Definition, MVD, defines a legal subset of the IFC schema 
and provides implementation guidance or agreements for all IFC concepts (classes, attributes, 
relationships, property sets, quantity definitions, etc.) used within this subset. It thereby 
represents the software requirement specification for the implementation of an IFC interface to 
satisfy the Exchange Requirements.

Model View Definitions are either defined within buildingSMART International, or by other 
organizations and interest groups.

ARCHICAD IFC Export and Import supports the following Model View Definitions:

• The Coordination View was the first Model View Definition developed by buildingSMART 
International and is currently the most widely implemented view of the IFC scheme. The 
main purpose of the Coordination View is to allow sharing of building information models 
among the disciplines of architecture, structural engineering, and building services 
(mechanical). It contains definitions of spatial structure, building, and building service 
elements that are needed for coordinating design information among these disciplines, and 
is supported by ARCHICAD. ARCHICAD is certified for both import and export of the latest 
version: IFC2x3 Coordination View 2.0. 

IFC4 scheme further divides the Coordination View into two Model View Definitions:

• IFC4 Reference View: Suitable for all BIM workflows based on reference models, where 
the exchange is mainly one-directional. Requested modifications of the BIM data, mainly 
of the shape representation, are handled by a change request to the original author.

• IFC4 Design Transfer View: Provides building information with support for editing of 
interconnected elements: inserting, deleting, moving, and modifying physical building 
elements and spaces, within the limited scope of parametric exchange. An example of a 
target scenario is an architect providing building design information to an engineer for a 
particular discipline, where geometric modifications may be needed. Note that the 
Design Transfer View is not meant for round-trip model exchange scenarios.

• TheIFC2x3  Coordination View (Surface Geometry) is a simplified publishing format (i.e. a 
subset) of the Coordination View. This format is suitable for viewing (since all IFC viewers 
support this format), design coordination, clash prevention during design, and clash 
checking, similarly to IFC4 Reference View. “Coordination View (Surface Geometry)” means 
that every element will be exported with its BREP (boundary representation) geometry. This 
method comes closest to reproducing the real shape of the element, together with its 
specialized sections, connections and solid operations. (However, the element’s parameters 
are lost, and BREP elements from an imported IFC file are transformed into non-editable 
elements.)

• The IFC2x3 Basic FM Handover View is an extended version of the Coordination View 
(developed by buildingSMART) that defines the general requirements for design applications 
to enable the handover of facility management information. The basic scope can be 
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summarized as the space and equipment list for the spatial and technical systems of a facility. 
Technically, the Basic FM Handover View fulfills the following requirements above and 
beyond those of the abovementioned Coordination View: ability to assign furnishing and 
equipment components to spaces (Space Containment, IFC System), to assign spaces to 
zones (IFC Zone), to assign a classification to spaces and components (Classification 
Reference), to assign manufacturer base properties to components (standard and custom IFC 
Properties), to assign doors and windows to spaces (Space Boundaries), to assign type 
information for components (IFC Type Product) and to export base quantities for all project 
components and spatial structures. This MVD is required in various projects defined by 
buildingSMART and other organizations. An example is the COBie (Construction-Operations 
Building information exchange), a specification used in the handover of Facility Management 
information. It is a spreadsheet data format for the delivery of a subset of building model 
information, rather than geometric model information. ARCHICAD’s BIM-quality models and 
IFC data exchange capabilities produces data output that is easily converted into COBie 
documentation, with the help of free or commercial conversion programs.

• There are several other Model View Definitions (generally the extended versions of the 
Coordination view) specified by organizations or development teams outside of 
buildingSMART International. An example is the Concept Design BIM 2010 model view 
definition that is supported/required by the General Services Administration (US GSA), 
Statsbygg (Norway) and Senate Properties (Finland). The additional MVDs require programs 
to provide IFC data above and beyond those of the Coordination View standard - such extra 
data include Classification Reference, Space Occupant, Actor, System and Time Series 
Schedule Assignments, and specific property sets and properties. ARCHICAD’s IFC interface 
provides the possibility to define, export and import these data types. As a result, users will 
be able to fulfill for example the GSA-specific classifications according to various OmniClass 
classes, Statsbygg and Senate Properties regulations.

For more information, see IFC Data Types and Working with IFC Data.

All Model View Definitions can be extended by add-on model view definitions which support 
additional exchange requirements: 

• the Quantity Take-off add-on view adds the ability to transmit base quantities for all spatial 
and building elements

• the Space Boundary add-on view adds building elements to space relationships to support 
models in thermal and energy analysis

• the 2D Annotation add-on view supports the exchange of additional 2D element 
representations and annotations of building models

ARCHICAD supports all of these additional data types.

See Export Options of IFC Translators.
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File Types
ARCHICAD supports the export and import of the following IFC data file formats: 

• .ifc: the default IFC exchange format using the STEP physical file structure

• .ifcXML: IFC data file using the XML document structure. This format is recommended for 
architects whose partners’ applications cannot read the original .ifc format, but can manage 
XML databases (such as budget, energy calculations, etc.). This format delivers the same 
model information as the plain .ifc format, but the elements and their properties are stored 
in a more informative structure. An .ifcXML file is normally 300-400% larger than an .ifc file.

• .ifcZIP: IFC data file using the ZIP compression algorithm. It is the compressed version of .ifc 
or .ifcXML. An .ifcZIP file usually compresses an .ifc down by 60-80% and an .ifcXML file by 
90-95%.

Note: .ifcZIP is compatible with e.g. Windows compressed folders, WinZip, etc. So if the 
recipient cannot read .ifcZIP, then a ZIP extractor application can open the file into .ifc or 
.ifcXML format.

IFC-based data exchange can be enhanced with BIM Collaboration Format (BCF)-based 
communication. In this workflow, you can assign comment topics to IFC model elements. Based 
on these, the other user can easily locate the referenced elements in the IFC model. BCF-based 
data exchange is particularly suited for marking changes or collisions (e.g. between architectural 
and structural elements). BCF-type communication can be done with the Mark-Up tool in 
ARCHICAD.
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IFC Data Types
This chapter summarizes the main IFC data types available in ARCHICAD.

IFC Entity

IFC Container

IFC Type Product

IFC Model Hierarchy

IFC Attributes

IFC Properties

IFC Classification Reference

IFC Assignments
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IFC Entity

In an IFC model, the project information (generated, for example, from an ARCHICAD project) is 
represented as a set of IFC Entities - such as elements, surfaces, and their relationships. Each IFC 
Entity (for example, an IfcWall) includes a fixed number of IFC Attributes, plus any number of 
additional IFC Properties. The IFC scheme encompasses several hundred entities, of which the 
building element-type entities (such as IfcWall and IfcColumn) represent only 25.

Some IFC Entities express characteristics of other entities. Some of these correspond to 
ARCHICAD attributes. These correspondences are mapped automatically when the IFC model is 
generated or exported, or when the IFC model is imported.

ARCHICAD Attribute IFC Entity

Layer IfcPresentationLayerAssignment

Building Material IfcMaterial

Surface IfcSurfaceStyleRendering
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At IFC import, you can override the IfcPresentationLayerAssignment, the IfcMaterial and the 
IfcSurfaceStyleRendering entities with preset ARCHICAD Attributes.

See Import Options.

This may lead to much cleaner project files, because the IFC model's attribute set won't be 
recreated if you do not want it. 

IFC Container

IFC Container (relating object of IfcRelAggregates) is an IFC entity that does not have its own 
body geometry, but its components (related objects of IfcRelAggregates) contain all geometry 
and structure-related data. 

In an ARCHICAD project,

• an ARCHICAD Curtain Wall is an IfcCurtainWall IFC Container entity with its Frame 
(IfcMember) and Panel (IfcPlate) components;

• IfcStair, IfcRamp and IfcRoof entities can also be IFC Containers if they originate from an IFC 
model that was exported by another application and merged into the ARCHICAD project 
earlier. For example, the geometry-defining components of an IfcStair container are typically 
IfcStairFlight, IfcSlab (with predefined type Landing), IfcRailings, or any kind of entity such as 
the simple IfcBuildingElementProxy.

Note:

• An ARCHICAD Stair or Ramp Object is mapped and exported as single (not container) 
IfcStair or IfcRamp element.

• No matter how complex the ARCHICAD Roof element, it will not be considered an IfcRoof 
container element. Rather, it will be a single IfcSlab, of predefined type “Roof”, having a 
single-component geometry.

Composite IfcMaterialLayerSet (extruded geometry) or IfcMaterialList 
(BREP geometry)

Profile IfcProfileDef

ARCHICAD Attribute IFC Entity
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• IFC export that uses the “Explode Composite and Complex Profile elements into parts” 
option (see Geometry conversion) generates IFC Container elements from building elements 
in the output IFC file: for example a composite wall element is saved as an “IfcWall”-type IFC 
Container element without geometry, and its skin parts will provide the geometry as 
“IfcBuildingElementPart” elements.

IFC Type Product

An IFC Type Product is an IFC Entity that defines a particular style/type of other entities by 
relating to them with common IFC Attributes and Properties. For example, IfcWindowStyle is an 
IFC Type Product, to which many windows (IfcWindow) refer.

ARCHICAD automatically generates IFC Type Product entities for all ARCHICAD element types. 
The following table shows some naming examples of the automatically generated IFC types, if 
there is no valid name mapping for Type Product entities driven by the IFC Scheme Setup.

See IFC Scheme Setup.

Of course, the default name values, together with all IFC data (Attributes, Properties and 
Classification Reference), can be edited manually. This may be necessary, for example, if Library 
Part name is not sufficient to identify the type (they may be created with the same Library Part, 
but the opening sizes are different); in this case, we can assign a custom automatic naming rule 
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that also contains size data: for example, "Library Part name" parameter + "Width" parameter + 
"x" static text + "Height" parameter.

ARCHICAD element (IFC 
Entity)

IFC Type Product Name Attribute of Type Product 
derived from

Column (IfcColumn) IfcColumnType Profile/Building Material name + profile 
size

Beam (IfcBeam) IfcBeamType Profile/Building Material name + profile 
size

Wall (IfcWall) IfcWallType Building Material/Composite name + 
thickness

Slab (IfcSlab) IfcSlabType Building Material/Composite name + 
thickness

Curtain Wall (IfcCurtainWall) IfcCurtainWallType “Curtain Wall Type” fix name

Curtain Wall Panel part 
(IfcPlate)

IfcPlateType Panel type (“Main” or “Distinct”) + panel 
size

Curtain Wall Frame part 
(IfcMember)

IfcMemberType Frame type (“Boundary”, “Mullion” or 
“Transom”) + profile size

Door (IfcDoor) IfcDoorStyle (IFC2x3) Library Part name

Door (IfcDoor) IfcDoorType (IFC4) Library Part name

Window (IfcWindow) IfcWindowStyle 
(IFC2x3)

Library Part name

Window (IfcWindow) IfcWindowType 
(IFC4)

Library Part name

GDL-based Objects e.g. IfcFurnitureType Library Part name

See IFC Scheme Setup.

The list and full management of the IFC Type Product entities can be managed only with the IFC 
Manager (in “Type Products” mode, see the illustration below).

See IFC Manager.
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IFC Model Hierarchy

An IFC model is composed of IFC Entities built up in a hierarchical order. As shown in the 
following illustration, each story level (IfcBuildingStorey) has its corresponding story in 
ARCHICAD - for example, when you import an IFC model, or apply IFC Manager for your current 
project.
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In ARCHICAD, all elements and objects are linked to a home story. Thus, by default, the IFC model 
hierarchy lists them under the IfcBuildingStorey of the same name as the elements’ home story. 
However, in IFC Manager, elements can be assigned directly to the IfcSite or IfcBuilding. So, for 
example, neighboring buildings (e.g. defined by the Morph tool) and site context elements 
(trees, fences, roads, etc.) can be assigned to the site instead of the project building with its story 
system.

See IFC Manager.

By default, the IFC elements (for example the IfcBuildingElements) and the IfcSpace entities are 
on the same hierarchy level in an IFC model. However, ARCHICAD Objects (e.g. furnishing and 
MEP elements) and Morphs - regardless of their Element Classification - can be displayed on and, 
for IFC export purposes, linked to the ARCHICAD Zone (IfcSpace) that contains them, instead of to 
their home story.

See IFC Manager Tree View in IFC Options.

The upper levels of the IFC model hierarchy - that is, IfcProject, IfcSite, IfcBuilding and IfcStorey - 
can only be managed through the IFC Manager, where you can also edit their IFC-related data. 

See IFC Manager.

The IFC Attribute values of these spatial elements, however, are derived from the data of the 
current ARCHICAD project.

Note: By default, ARCHICAD assigns identical GlobalID attributes to the following entities: IFC 
Project, IFC Site, IFC Building, and IFC Story. More precisely, the Global IDs will be identical 
provided that the respective ID fields, defined at ARCHICAD’s Project Info dialog box (File > 
Info) contain identical keywords (or no value at all). However, you can alter these keywords 
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in the Project Info dialog box to control whether the spatial entities have identical or 
different GlobalIDs.

See the example and illustration at Data Mapping.

IfcSite is the geographic position of the IfcProject. It can have a geometry but a geometry is not 
required. In ARCHICAD, site geometry is represented by Mesh elements and Site-type Objects 
and elements with “Site Geometry” Element Classification.

ARCHICAD can handle, and so can import, one building (IfcBuilding) only. But it can import more 
than one IfcSite, even though the IfcSite is above the IfcBuilding in the hierarchy. Thus, when 
importing an IFC file that contains multiple buildings, you can choose only one to import.

See Step 4: Building or Site Selection.

However, other applications can export a building’s topography into multiple IfcSites. In this 
case, importing the IfcBuilding will import all of the IfcSites, merged into the one IfcSite that 
actually contains the imported IfcBuilding. The result is that you will end up with a single IfcSite 
and a single IfcBuilding, but the IfcSite includes all of the IfcSites.

IFC Attributes

IFC Attributes are the main identifiers of IFC Entities. The names of IFC Attributes are fixed, 
having been defined by buildingSMART as part of the IFC standard code.

In the case of ARCHICAD, most of these IFC Attribute names are derived from the project. For 
example, the IFC Attributes of an IfcWall building element: 

• GlobalId: the Globally Unique Identifier of the IfcWall in the IFC model (not editable).

• OwnerHistory: the assignment of the information about the current ownership of the 
IfcWall.

• Name: its factory-default derived value is IfcWall’s ARCHICAD ID (Wall Settings dialog box > 
Categories and Properties panel).

• Description: an optional textual description.

• ObjectType: an optional text to define a subtype of an element or add type information to it.

• Tag: its factory-default derived value is the IfcWall’s ARCHICAD “Unique ID” (not equal to IFC 
GlobalId).
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• In order to provide fast access, OwnerHistory is directly attached to all independent objects, 
relationships and properties. Its components and values are derived from project data and 
hidden in the ARCHICAD user interface. It includes for example the owning actor 
(OwningUser) of which multiple values are derived from ARCHICAD’s Project Info (File > 
Info).

• “Factory-default” means that as long as no custom data is entered, and as long as the value 
has not been mapped using a rule (see IFC Scheme Setup), the program provides this value 
for the Attribute.

IFC Properties

IFC Properties are additional (mostly IFC Type-specific) parameters assigned to an IFC Entity. IFC 
Properties can be either standard, so-called “IFC2x3 scheme” data (which are defined by 
buildingSMART and stored in property sets whose names begin with the prefix “Pset_”); or they 
can be non-standard, which are created by the exporting application using any property name 
and stored in any property set (the names of these property sets usually contain the name of the 
exporting application), or the IFC model view definition required for the property.

Examples:

• The ARCHICAD Element Schedule Fields (Properties and Parameters) can be automatically 
exported from an ARCHICAD model as IFC Properties and/or IFC Quantities with IFC export.

See Export Options.

• IFC Property and Attribute values can be set automatically from ARCHICAD properties, 
parameters, quantities and Library Part parameters by using mapping rules defined by the 
current scheme. In this case, the IFC data will be exported with its rule-defined name. In the 
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IFC Manager and in Element Settings dialog boxes, these values are shown with a lock icon 
(indicating that they have been mapped). However, their value can be modified at the 
element level as needed. 

See IFC Scheme Setup.

Some properties are mapped and are not editable (their properties are shown in gray), because 
there is a 1-to-1 mapping relationship with ARCHICAD parameters. Examples: the “Renovation 
Status” (same as the Renovation Status in ARCHICAD); the “LoadBearing” (same as Structural 
Function in ARCHICAD); and the “IsExternal” (same as ARCHICAD Position Category items).

IFC Classification Reference

A Classification Reference (IfcClassificationReference) is used for arrangement of IFC elements 
into a category. You can assign an Item Reference identifier, a classification Name attribute and 
some other optional parameters to all project elements (such as the building, the stories, the 
building elements, or the zones). For example, classify building elements by the proper 
OmniClass table required by the US GSA, or by the Uniclass classification system required in the 
UK.

You can classify elements with this system both in IFC Manager and the element Settings dialogs.

See Custom Data.
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IFC Assignments

IFC Assignments (IfcRelAssigns) define the relationship between the different project elements. 
Each assignment type can have its own IFC Attribute (the most significant is the Object Type), 
and standard and custom IFC Properties. The major assignment types of the IFC standard are the 
following:

• IFC Group (IfcGroup): Use this to group any project elements (building element, story etc.) 
together. For example: the column and beam components of a frame standing are grouped 
together. Grouping by multilevel-hierarchy is also available for IfcGroup assignments. For 
example, you can group the frame standing groups in a ‘frame-system’ group.

• IFC Zone (IfcZone): Use this to group IfcSpace elements (the equivalent of ARCHICAD Zones) 
together. For example: ARCHICAD Zones having the identical function are grouped into an 
IfcZone named e.g. “Security Zone.” Grouping by multilevel-hierarchy is also available for 
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IfcZone assignments. For example, you can group some ARCHICAD Zones (IfcSpaces) in an 
IfcZone (Security Zones) that is a part of a higher level IfcZone group (Governmental Zones).

• IFC System (IfcSystem): Use this to group any project elements (especially MEP elements) in 
a system hierarchy manually, by using MEP Modeler defined systems, or by importing 
systems exported from e.g. MEP applications. Definition of sub-system hierarchy (parent and 
child system) is also available. For example: group elevators in a vertical circulation system 
which can be a child system of a mechanical system. Or, assign plumbing elements to the 
cold water sub-system of a plumbing system. You can also tie systems to a spacial structure 
relation (IfcSite, IfcBuilding, IfcStorey or IfcSpace). For example, add to a duct system all the 
ARCHICAD Zones (IfcSpace) that it runs through.

• Actor (IfcActor): Use this to assign an actor (person and/or organization) and its role (e.g. 
owner, architect, client) to any project element (project, story, building element etc.). 
Example: assign the Actors “Project Architect” and “Project Client/Owner” (GSA 
requirements) to the (Ifc)Project.

• Space Occupant (IfcOccupant): Use this to define the occupancy relationship between an 
actor (person and/or organization) and one or more IfcSpaces or their groups (IfcZone).

• Time Series Schedule (IfcTimeSeriesSchedule): Use this to set occupancy, lighting and 
equipment schedule assignment to any project element such as an ARCHICAD Zone. For 
example: issues (values) can be assigned to IfcSpaces with definite start and end dates, time 
steps, and annual, monthly, weekly, daily or custom repeating periods.

ARCHICAD supports all of the above mentioned IFC Assignment types:

• the IFC Manager interface lets you define any assignments in your project and manage all 
their IFC data;

• all of the above mentioned assignment data are created at IFC model import (for example 
IfcSystems stored in an MEP-type IFC model, IfcZones defined in an FM application);

• all available IFC Assignments (defined manually or previously imported) are exported with a 
new IFC model mapped from the current ARCHICAD project.

See Assignments.
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IFC Element Types
ARCHICAD’s Element Classification (Element Settings > Categories and Properties Panel) affects 
that element’s IFC type (in IFC data management, IFC export and import). The table below shows 
the bi-direction mapping rule between the Element Classification and the IFC type (and its 
further effect on IFC Type Product type definition). In some cases, Element Classification sets the 
“Predefined Type” IFC Attribute value, giving more detailed IFC type classification (text in 
brackets shows it in the IFC Type column). For example, the “Roof” Element Classification sets 
“IfcSlab” IFC Type, with a Predefined Type Attribute value of “Roof”.

Element 
Classification

IFC Type 
(PREDEFINED 

TYPE)

Default IFC Type 
Product

Alternative IFC Type 
Product

(can be set in IFC 
Manager)

Beam IfcBeam IfcBeamType  

Building 
Element Proxy

IfcBuildingElement
Proxy

IfcBuildingElement
ProxyType

 

Cable Carrier 
Fitting

IfcFlowFitting IfcCableCarrier
FittingType

IfcDuctFittingType, 
IfcJunctionBoxType, 
IfcPipeFittingType

Cable Carrier 
Segment

IfcFlowSegment IfcCableCarrier
SegmentType

IfcCableSegmentType, 
IfcDuctSegmentType, 
IfcPipeSegmentType

Ceiling IfcCovering (CEILING) IfcCoveringType  

Column IfcColumn IfcColumnType  

Covering IfcCovering 
(NOTDEFINED)

IfcCoveringType  

Curtain Wall IfcCurtainWall IfcCurtainWallType  

Discrete 
Accessory

IfcDiscreteAccessory IfcDiscreteAccessory
Type

IfcVibrationIsolatorType

Distribution 
Chamber 
Element

IfcDistribution
ChamberElement

IfcDistribution
ChamberElementType

 

Distribution 
Control Element

IfcDistributionControl
Element

IfcControllerType IfcActuatorType, 
IfcAlarmType, 
IfcFlowInstrumentType, 
IfcSensorType
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Distribution 
Element

IfcDistribution
Element

IfcDistribution
ElementType

IfcDistributionChamber
ElementType, 
IfcActuatorType, 
IfcAlarmType, 
IfcControllerType, and more

Distribution 
Flow Element

IfcDistributionFlow
Element

IfcValveType IfcAirTerminalBoxType, 
IfcDamperType, 
IfcElectricTimeControlType 
IfcFlowMeterType, 
IfcProtectiveDeviceType, 
IfcSwitchingDeviceType

Door IfcDoor IfcDoorStyle  

Duct Fitting IfcFlowFitting IfcDuctFittingType IfcCableCarrierFittingType, 
IfcJunctionBoxType, 
IfcPipeFittingType

Duct Flow 
Terminal

IfcFlowTerminal IfcAirTerminalType IfcElectricApplianceType, 
IfcElectricHeaterType, 
IfcFireSuppressionTerminal
Type, IfcGasTerminalType, 
IfcLampType, 
IfcLightFixtureType, 
IfcOutletType, 
IfcSanitaryTerminalType, 
IfcStackTerminalType, 
IfcWasteTerminalType

Duct Segment IfcFlowSegment IfcDuctSegmentType IfcCableCarrierSegment
Type, 
IfcCableSegmentType, 
IfcPipeSegmentType

Energy 
Conversion 
Device

IfcEnergyConversion
Device

IfcTransformerType IfcAirToAirHeatRecovery
Type, IfcBoilerType, 
IfcChillerType, IfcCoilType, 
IfcCondenserType, 
IfcCooledBeamType, 
IfcCoolingTowerType, and 
more

Fastener IfcFastener IfcFastenerType IfcMechanicalFastenerType

Element 
Classification

IFC Type 
(PREDEFINED 

TYPE)

Default IFC Type 
Product

Alternative IFC Type 
Product

(can be set in IFC 
Manager)
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Flow Controller IfcFlowController IfcValveType IfcAirTerminalBoxType, 
IfcDamperType, 
IfcElectricTimeControlType, 
IfcFlowMeterType, 
IfcProtectiveDeviceType, 
IfcSwitchingDeviceType

Flow Moving 
Device

IfcFlowMovingDevice IfcPumpType IfcCompressorType, 
IfcFanType

Flow Storage 
Device

IfcFlowStorageDevice IfcTankType IfcElectricFlowStorage
DeviceType

Flow Treatment 
Device

IfcFlowTreatment
Device

IfcFilterType IfcDuctSilencerType

Footing IfcFooting 
(NOTDEFINED)

(not available in 
IFC2x3 scheme)

 

Furniture IfcFurnishingElement IfcFurnishingElement
Type

IfcFurnitureType, 
IfcSystemFurnitureElement
Type

Lamp IfcFlowTerminal IfcLampType IfcAirTerminalType, 
IfcElectricApplianceType, 
IfcElectricHeaterType, 
IfcFireSuppressionTerminal
Type, IfcGasTerminalType, 
IfcLightFixtureType, 
IfcOutletType, 
IfcSanitaryTerminalType, 
IfcStackTerminalType, 
IfcWasteTerminalType

Light Fixture IfcFlowTerminal IfcLightFixtureType IfcAirTerminalType, 
IfcElectricApplianceType, 
IfcElectricHeaterType, 
IfcFireSuppressionTerminal
Type, IfcGasTerminalType, 
IfcLampType, IfcOutletType, 
IfcSanitaryTerminalType, 
IfcStackTerminalType, 
IfcWasteTerminalType

Element 
Classification

IFC Type 
(PREDEFINED 

TYPE)

Default IFC Type 
Product

Alternative IFC Type 
Product

(can be set in IFC 
Manager)
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Mechanical 
Fastener

IfcMechanical
Fastener

IfcMechanical
FastenerType

 

Member IfcMember IfcMemberType  

Pile IfcPile (NOTDEFINED) (not available in 
IFC2x3 scheme)

 

Pipe Fitting IfcFlowFitting IfcPipeFittingType IfcCableCarrierFittingType, 
IfcDuctFittingType, 
IfcJunctionBoxType

Pipe Flow 
Terminal

IfcFlowTerminal IfcSanitaryTerminal
Type

IfcAirTerminalType, 
IfcElectricApplianceType, 
IfcElectricHeaterType, 
IfcFireSuppressionTerminal
Type, IfcGasTerminalType, 
IfcLampType, 
IfcLightFixtureType, 
IfcOutletType, 
IfcStackTerminalType, 
IfcWasteTerminalType

Pipe Segment IfcFlowSegment IfcPipeSegmentType IfcCableCarrierSegment
Type, 
IfcCableSegmentType, 
IfcDuctSegmentType

Plate IfcPlate IfcPlateType  

Railing IfcRailing 
(NOTDEFINED)

IfcRailingType  

Ramp IfcRamp 
(NOTDEFINED)

(not available in 
IFC2x3 scheme)

 

Ramp Flight IfcRampFlight IfcRampFlightType  

Reinforcing Bar IfcReinforcingBar (not available in 
IFC2x3 scheme)

 

Reinforcing 
Mesh

IfcReinforcingMesh (not available in 
IFC2x3 scheme)

 

Roof IfcSlab (ROOF) IfcSlabType  

Site Geometry part of the IfcSite 
geometry

(not available)  

Element 
Classification

IFC Type 
(PREDEFINED 

TYPE)

Default IFC Type 
Product

Alternative IFC Type 
Product

(can be set in IFC 
Manager)
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You can check the IFC Type mapping result of Element Classification changes under “IFC 
Properties” (Element Settings > Categories and Properties Panel) or in the IFC Manager. You can 
also use Find & Select to filter the project by “IFC Type” criteria, or use Interactive Element 
Schedule to list this data for ARCHICAD elements. For example, you can select or list just the 
model elements having IfcSlab IFC Type.

The types of the IFC Type Product generated automatically for an element can be checked and 
managed in IFC Manager only. Also, in some cases, the default IFC Type Product can be modified 
to an alternative IFC Type Product within the IFC Manager.

See IFC Type Product.

Element Classification is very useful when you have to model building elements that have no 
exact counterpart in the ARCHICAD toolbox. For example, you want to model ceiling elements 
with the Slab tool. By default, the Slab tool uses the “Slab” Element Classification, but you can 
easily modify it to “Ceiling,” which also affects the IFC Type of the elements defined with the Slab 
tool: each “Ceiling”-classified element will be managed (export and data management) as 
“IfcCovering” element with a Predefined Type of “Ceiling”.

Slab IfcSlab (FLOOR) IfcSlabType  

Stair IfcStair (NOTDEFINED) (not available in 
IFC2x3 scheme)

 

Stair Flight IfcStairFlight IfcStairFlightType  

Tendon IfcTendon 
(NOTDEFINED)

(not available in 
IFC2x3 scheme)

 

Tendon Anchor IfcTendonAnchor (not available in 
IFC2x3 scheme)

 

Transport 
Element

IfcTransportElement 
(NOTDEFINED)

IfcTransportElement
Type

 

Wall IfcWall IfcWallType  

Window IfcWindow IfcWindowStyle  

Element 
Classification

IFC Type 
(PREDEFINED 

TYPE)

Default IFC Type 
Product

Alternative IFC Type 
Product

(can be set in IFC 
Manager)
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Hint: Element Classification has another advantage, not directly related to IFC exchange: you 
can define Properties (Options > Property Management) by Element Classification, use Find 
& Select to filter the project by “Element Classification” criteria, or use Interactive Element 
Schedule to list this data for ARCHICAD elements. For example, you can select or list just the 
elements defined with the Slab tool but classified as “Ceiling”, or all elements defined by any 
tool, but classified as “Furniture”.

In the case of Objects, if it has a Subtype (for example, an Object having a Column-subtype), that 
subtype will map the Element Classification and thus the IFC Type. For example: “Column” 
Subtype sets “Column” Element Classification and thus “IfcColumn” IFC Type. 

Certain subtypes are automatically assigned the Element Classification and so the IFC element 
types that correspond to their group name: for example the “Bed”, “Seating” or “Table” Subtypes 
are automatically set to “Furniture” Element Classification and so “IfcFurnishingElement” IFC 
Type (since its group name is the “Furnishing” subtype).

You can override the default Subtype-Element Classification mapping (and thereby the IFC Type 
categorization), if you modify the default “Element Classification” value to another value, in the 
Categories and Properties panel of Object Settings.
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An ARCHICAD element classified as “Site Geometry” will become, as part of the IFC export 
process, part of the IfcSite geometry (provided that the ARCHICAD element has a geometry). 
Since the IFC data of an IfcSite can be edited only in IFC Manager, you will not see the “Manage 
IFC Properties” interface in the Categories and Properties panel of such ARCHICAD elements.

A Grid System (Design menu) is exported as an IfcGrid container and its members are 
represented as IfcGridAxis elements. Independent Grid Element instances (not part of a Grid 
System, but rather defined with the Grid Element tool) are also exported as IfcGridAxis elements, 
but grouped in a single IfcGrid container. The export of Grid elements occurs only if the 
appropriate option in the IFC Translator is enabled.
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All 2D elements (different line types, fills, texts and dimensions) are mapped as IfcAnnotation 
elements based on the IFC scheme. The IFC standard does not support (and is not aiming for) the 
intelligent export of dimensions, so exporting a dimension item will explode it into line and text 
components, which are grouped in an IfcAnnotation container. The export of 2D elements occurs 
only if the appropriate option in the IFC Translator is enabled.

See Import/Export Filter Options.

Element conversion rules according to IFC Types at IFC model import:

• If the geometry of an imported IFC model element is “extruded” (and the “Construction 
elements...” conversion option is used as IFC import option) and can be recreated using an 
ARCHICAD tool (not an Object-type tool), then the imported element will be converted into a 
native, editable ARCHICAD element based on the IFC Type-Element Classification 
bidirectional mapping. For example, an IfcBeam will become an ARCHICAD Beam (with 
“Beam” Element Classification).

• If the geometry of an imported IFC model element is “BREP”, or if it cannot be recreated with 
a non-Object-type ARCHICAD tool (that is, it has no ARCHICAD tool counterpart), then it will 
be converted into an Object or a Morph (depending on the Import Options > Geometry 
Conversion setting of the IFC Translator), but using the correct Element Classification derived 
from the IFC Type. For example, a BREP IfcBeam will be converted to an ARCHICAD Object 
(with “Beam” Subtype) or to a Morph. In both cases their Element Classification will be 
“Beam”.

See Import Options of IFC Translators.

“Extruded” geometry is the standard IFC geometry representation, which retains the elements’ 
parameter values (such as thickness, height, location of reference line or edge, skin structure of 
composites). However, certain specialized sections are not retained. “Boundary representation” 
(BREP) geometry method comes closest to reproducing the shape of the element, together with 
its specialized sections and connections (but the element’s parameters are lost).

An ARCHICAD’s element classification affects that element’s IFC export type. The mapping 
displayed in the above table shows the default and recommended situation, when an element’s 
default element classification value (set under “Element Classification” in the Categories and 
Properties Panel of element Settings) is used.
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IFC-Related Functions
The following is a summary of the commands and functions that are affected by the 
management of the IFC model and data (in the event that the IFC Add-On has been installed).

Note: To handle IFC, the IFC Add-On is automatically inserted into the ARCHICAD 
environment during ARCHICAD installation. The IFC add-on is updated with each ARCHICAD 
Hotfix. Check the latest Hotfix at: http://www.graphisoft.com/support.

IFC Data Handling
• IFC Manager (File > Interoperability > IFC)

• Manage IFC Properties (Element Settings dialog box > Categories and Properties panel > IFC 
Properties)

• IFC Scheme Setup (File > Interoperability > IFC)

• IFC Options (File > Interoperability > IFC)

• Find & Select (Edit menu)

• Schedules and Lists (Document menu)

• Zone Stamp (Design > Design Tools > Zone)

• Labels (Document > Documenting Tools) 

See Working with IFC Data.

IFC Export Functions
• Save as (File menu)

• Merge to IFC Model (File > Interoperability > IFC)

• Publish (Document menu)

See Export Functions.

IFC Import Functions
• Open (File Menu)

• Merge (File > Interoperability)

• Update with IFC Model (File > Interoperability > IFC)

See Import Functions.

Change Detection
• Detect IFC Model Changes (File > Interoperability > IFC)

See Change Detection.

Collision Detection
• Detect Collisions (Design > MEP Modeling; in MEP Modeler environment)
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Import/Export Settings
• IFC Translation Setup (File > Interoperability > IFC)

See Import/Export Settings.

• Model Filter (at both import and export functions)

See Model Filter.
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Working with IFC Data
You can manage IFC Data in the following ways: 

In the Categories and Properties panel of Element Settings, you can assign and view IFC 
Attributes, standard and custom IFC Properties, and IFC Classification References. In addition, 
use Element Settings to carry out element classification (by Element Classification (IFC Type), 
Structural Function, Position and/or Renovation Status).

See Element Settings Dialog.

Use the IFC Manager to get an overview of the IFC hierarchy of the current ARCHICAD project; to 
navigate between the IFC model and ARCHICAD elements; to manage IFC data from a global 
perspective; and to create and manage IFC Assignments and IFC Type Products (this function is 
not available anywhere else). Unlike the Element Settings, you can use the IFC Manager to assign 
new IFC data not just to building elements and Zones, but to any other spatial elements including 
Stories, Building, Site, and Project.

See IFC Manager.

Note: Naturally, the Attributes, Properties and Classification References defined in the IFC 
Manager are immediately reflected in the relevant Element Settings dialogs, and vice versa.

Element Settings dialog IFC Manager

management 
level

element-level only project level

IFC data 
owner

- building elements - building elements

- Zone (IfcSpace) - spatial elements:

-- IfcProject

-- IfcSite

-- IfcBuilding

-- Story (IfcBuildingStorey)

-- Zone (IfcSpace)

- IFC Assignments

- IFC Type Products

- IFC Containers

Functions - collects and lists IFC data - collects and lists IFC data

- enables you to create, edit and delete 
IFC data

- enables you to create, edit and 
delete IFC data

- enables you to use predefined rules - enables you to use predefined rules

- filters scheme properties - filters scheme properties
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The IFC model’s data structure can be scheme-driven. This means that you assign a scheme to a 
project. Use the scheme-based workflow:

1. to store or create IFC data (Attributes, standard and custom Properties, Classification 
Reference) which are important to this project

2. to map IFC data values to ARCHICAD data values

3. to filter the property views of the IFC Manager and Element Settings dialog boxes so that they 
contain just the scheme data

4. to limit saved IFC data to just the scheme-specific data

See Import/Export Settings.

In sum, the use of a scheme enables you to tailor IFC data management and export at the project 
level, rather than always having to use the entire IFC standard property database. Specifically, 
the scheme-based workflow supports the following goals:

• data-specified interoperability with other disciplines using common data mapping

• company standard property management

• compliance with strict export requirements of IFC or other documentation standards (see 
Model View Definitions).

The first two functions of the scheme based workflow (listed above), and management of the 
scheme’s xml file, are available through the IFC Scheme Setup.

See IFC Scheme Setup.

IFC Options settings can have an effect at the project level, with respect to the visualization of 
the IFC hierarchy and data in the IFC Manager and in data storage.

See IFC Options.

Use the Find & Select command to search for any elements by their IFC Attribute, Property, or 
Classification Reference values.

See Find and Select Elements by IFC Data.

Use the Interactive Element Schedule to list any elements by their IFC Attribute, Property, or 
Classification Reference values.

See Scheduling Elements with IFC Data.

Use the Label Type called “Categories and Properties”, from Label Settings, to display Categories 
and Properties data (including IFC data) assigned to building elements on Floor Plan views, 

- filters only IFC data having values - filters only IFC data having values

- navigates between the ARCHICAD 
model and the IFC model

- displays Zone (IfcSpace) 
containment

- enables you to assign elements 
directly to the IfcSite or IfcBuilding

Element Settings dialog IFC Manager
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Sections, Elevations, Worksheets, Details, 3D Documents and their exported drawing formats 
(for example PDF). Add IFC data to this Label in the Custom Settings panel of Label Settings.

Use the Zone Stamp to place Categories and Properties data (including IFC data) assigned to 
ARCHICAD Zones (IfcSpace) on 2D views and documentation. Add IFC data to Zone Stamps in the 
Zone Stamp panel of Zone Settings.

Element Settings Dialog

ARCHICAD elements created out of imported IFC model elements display their standard and 
custom IFC data, at the element level, in their respective Settings dialog boxes (Categories and 
Properties panel > IFC Properties).

Note: Imported IFC elements and their properties (depending on the translator used) 
generally (by default) are protected against modification in accordance with the Reference 
model concept. Of course, by activating the layers of those elements, those elements too 
can be modified as needed.

In Element Settings, you can manage (define and edit) IFC data (Attributes, standard and custom 
Properties and Classification References) for searching (Find & Select), scheduling, labeling and 
IFC model export purposes. New IFC data can be added to the related elements manually or 
automatically, based on predefined rules in the Manage IFC Properties dialog. The interface of 
the Manage IFC Properties and its all functions are the same as the right side of the IFC Manager 
dialog box.

For detailed function descriptions, see IFC Manager and Creating and Editing IFC Data.

Note: The available standard IFC Attribute and Property data types depend on the element’s 
“Element Classification” value. For example, if an ARCHICAD Wall element uses its “Wall” 
Element Classification, then its IFC Type will be an IfcWall, and only those standard IFC data 
sets will be available which correspond to IfcWall IFC Type (e.g. the Pset_WallCommon 
Property Set). If its Element Classification is “Column”, then the IFC standard properties 
corresponding to IfcColumn will be available (e.g. the Pset_ColumnCommon properties).

The new data - with their values, or else just the checked items without values - will appear 
under IFC Properties. Here, you can assign values to the available data fields that are still empty.
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IFC Manager

The IFC Manager (File > Interoperability > IFC) provides a hierarchical overview of the current 
project’s IFC model database with the following functions:
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• Collects and lists all IFC model entity generated from the ARCHICAD project (including IFC 
import content) in a hierarchy

• Lists all data available for all project elements based on the applied IFC scheme

See IFC Scheme Setup.

• Enables you to create new IFC (custom Properties and Classification Reference) data besides 
the scheme data

• Enables you to group elements or assign entities/issues to elements (called IFC Assignments) 
and manage their IFC data

• Enables you to manage IFC Type Products assigned to elements with their with their IFC data

See Creating and Editing IFC Data.

• Enables you to assign elements directly to the IfcSite or IfcBuilding. For example, the 
neighboring buildings and site context elements (trees, fences, roads, vehicles etc.) can be 
assigned to the IfcSite; thereby, their default direct relation to their home story is removed.

• Updates the IFC model with the modifications of the ARCHICAD project

• Navigates easily between the ARCHICAD model and the IFC model

• Filters the IFC model by elements visible in the current view (this is the default filter set in 
the IFC Manager. The entire model can be shown by inactivating the “List visible model 
elements only” button; see later).

• Filters available data by scheme (that is, with non-scheme custom data hidden)

• Filters only the IFC data items having values in the current project 

• Finds elements both in the IFC and ARCHICAD models by their IFC GlobalId (Globally Unique 
Identifier) Attribute

• Displays Zone (IfcSpace) containment

See the IFC Manager Tree View in IFC Options.

Note: If you modify settings in IFC Manager, then leave the dialog box, you can undo your 
modifications with ARCHICAD’s Undo command.

The upper left side of the IFC Manager, the containment tree, displays the IFC model hierarchy 
and lists IFC Entities one by one according to their “IFC Type” classification.

See IFC Model Hierarchy.

The right side of the dialog box displays the available IFC Attributes, Properties grouped in 
Property Sets, and Classification References of any element you have selected in the tree (in case 
of multi-selection, the IFC data of the last-selected element are shown). At the top of the list, the 
numbers of selected/editable elements are shown.

Use the “Show only Scheme items” toggle button to filter as follows:

• if it is active, then you will display only those current scheme data that are used in the 
project (that is, the current content of IFC Scheme Setup).

• if it is inactive, then displayed data will include, in addition to scheme data, the new 
properties created here and in the Element Settings dialog boxes, as well as custom (non-
scheme) data that have been added during an import process. 

Activating this button can be useful: if your scheme corresponds to a particular standard or 
export requirement (e.g. COBie), then displaying only the scheme-defined necessary data makes 
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it much easier to navigate among IFC data, which otherwise are very numerous. If you replace 
one scheme with another, then those data that were part of the old scheme but are not part of 
the new scheme become “custom”. Switching schemes, then, does not result in any data loss; 
data you input for the original scheme will not be deleted. Thus, you can switch schemes as 
needed to comply with various export requirements. For example, in one instance you might 
save according to the COBie scheme; the next time you may use the Concept Design BIM 
scheme; another time you will use a structural or MEP scheme.

Note: When saving, you can specify for each translator whether the save should include only 
scheme-specific data with values assigned; or all data. 

See Export Options at IFC Translation Setup.

The property list on the right side of the IFC Manager can be further filtered using the “Show 
only items with values” button. This will display only those IFC data or scheme data which have 
assigned values. (Whether it displays IFC data or scheme data depends on the status of the 
“Show only Scheme items” button.)

Note: A property whose field is empty, but whose checkbox is enabled, counts as a property 
that has a value assigned. 

The IFC Manager palette is a modeless dialog box, so you can keep it open while working in the 
ARCHICAD project:

• If elements are created or deleted in the ARCHICAD model, the containment tree will not 
register these changes automatically. If a refresh is needed, a message appears below (“Tree 
is not up-to-date!”). To synchronize the containment tree of the IFC Manager with the 
project content, click on the “Synchronize list to model” button above the list. (If this button 
is gray, it means the tree view is up-to-date.)

• To find and select IFC Entities of the containment tree in the ARCHICAD model, just select 
them (multiple selection also works) in the tree and click “Show list selection in model” 
button. The program then attempts to display and select the elements in the active window 
(Floor Plan or 3D view only). In a Floor Plan view, if the element is not visible, then ARCHICAD 
automatically switches to the Home Story of the selected element. If it is still not visible, then 
a warning dialog appears. In a 3D view, if the element is not visible, a warning dialog appears.

• To find and select ARCHICAD model elements in the containment tree, just select them 
(multiple selection also works) in the current view (Floor Plan or 3D view) and click the 
“Show model selection in list” button. (It is recommended to use this button if the tree 
structure has already been synchronized with the model.)
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By default, the containment tree shows the entire IFC model and data of the current ARCHICAD 
project. By activating the “List visible model elements only” button, you can narrow the 
containment tree to those elements that are visible in the current view. Thus, by clicking the 
button, you can switch the tree and data content between the entire IFC model and just the 
visible IFC Entities.

Note: If you use the button to narrow the data content, and then switch views in the project, 
you can update the data shown in the IFC Manager by using “Synchronize list to model”, 
because different views may have different active layers.
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You can locate elements in the containment tree based on their IFC identifiers (GlobalId 
Attribute, ARCHICAD IFC ID, External IFC ID). Switch to the search mode using the Find by 
GlobalId tool (third icon underneath the containment tree). Just type the identifier (or any 
portion of it) of the element you would like to find in the IFC Manager into the empty field below 
the tool, and then click “Search by IFC ID”. Choosing any item in the “Search result” list will select 
and show the assigned element in the containment tree. Clicking “Show list selection in model” 
finds and select the element in the ARCHICAD model too.

The IFC Manager locates and displays all the IFC Assignments and IFC Type Products that exist in 
the project, plus all the elements which refer to them. To see them, switch to “Assignments” or 
“Type Products” view/definition mode using the first or second icon underneath the 
containment tree. To narrow the displayed Assignment/Type Product data to that of the selected 
elements only, click the “Filter for selected element(s)” button. This way, for example, you can 
easily check whether any given ARCHICAD Zone (IfcSpace) belongs to one or more IFC Zones, and 
if so, which one(s).

For more information about the management of Assignments and Type Products, see Creating 
and Editing IFC Data.

In ARCHICAD, all elements and objects are linked to their Home Story. Therefore, by default, 
elements will be listed in the IFC model hierarchy under the IfcBuildingStorey that corresponds 
to the Home Story. You can break this link (to the IfcBuildingStorey) by dragging the element out 
of its IfcBuildingStorey location into the IfcSite (see illustration below). For example, a 
neighboring building modeled with a Morph or a tree Object that serves as a Site context 
element can be placed into the IfcSite folder. You can also place elements into the IfcBuilding 
(such as an element that is logically tied directly to a particular building rather than a story).

To return the element to its automatic IfcBuildingStorey classification (corresponding to its Home 
Story), just drag it out of the IFC Manager.
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Creating and Editing IFC Data

Note: 

• In Teamwork, the following data in the IFC Manager can be reserved and modified: 
IfcProject, IfcBuilding, IfcSite, Assignments and Type Products. IFC Properties of model 
elements (e.g. IfcWall, IfcColumn, IfcBeam) can be modified via IFC Manager only if those 
elements are not reserved by any other user.

• If you modify settings in IFC Manager or the Manage IFC Properties dialog box, and you 
then leave the dialog box, you can undo your modifications with ARCHICAD’s Undo 
command.

Scheme Data
IFC Attributes, Properties and Classification Reference entities defined by a scheme (IFC Scheme 
Setup) can have values that are optionally assigned or else derived.

To assign an optional scheme-defined IFC Attribute or Property to an element, check the box in 
front of the element. Use the Value field to define its value depending on the value Type (e.g. 
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Label, Integer, Boolean). To define values of a scheme-defined Classification Reference data, type 
them manually or use the Apply Predefined Rule command (see its function later, at Custom 
Data). Any element that is not assigned a value will be exported that way.

Derived values (identified with a lock icon) will come from a source of existing ARCHICAD data. If 
a derived value is shown in:

• black, it can be overwritten with a custom value

• gray, it cannot be modified here in the IFC Manager; it can be modified only at its source, 
where that particular ARCHICAD value comes from.

Examples for factory default mapping rules for IfcBeams:

• The Name Attribute is derived from the ARCHICAD Beam-classified element’s ID parameter 
(found in the Categories and Properties panel of Element Settings).

• The value of the IsExternal property (Pset_BeamCommon), either “True” or “False”, is 
derived from the corresponding ARCHICAD element’s Position classification (either 
“Exterior” or “Interior”).

• The value of the LoadBearing property (Pset_BeamCommon), either “True” or “False”, is 
derived from the corresponding ARCHICAD element’s Structural Function classification 
(either “Load-Bearing Element” or “Non-Load-Bearing Element”).

Derived properties can also originate from the mapping rules used in IFC Scheme Setup.

See IFC Scheme Setup.

Custom Data
Use the New Property/Classification option to create new custom IFC Properties or Classification 
References. Alternatively, use the Apply Predefined Rule command to create them automatically.
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To create a new custom IFC Property:

1. Define a name for the new custom Property Set (Pset); or else choose from the list of existing 
Property Set names defined previously for the same element type (click the arrow icon to 
access this list). For example, if you are creating a new Property for an IfcWall, the list 
contains all the Pset names earlier assigned to other IfcWalls.

Note: To avoid errors (and to keep the standard property definition rules), do not use the 
standard “Pset” prefix when giving a name to your custom Property Sets.

2. Define a name for the new custom Property.

3. Set the type of the new Property (single, enumerated, complex, etc.).

Property type Definition

Single Value A property object which has a single (numeric or descriptive) value 
assigned.

Enumerated Value A property object whose value is chosen from an enumeration.

Bounded Value A property object which has a maximum of two (numeric or 
descriptive) values assigned, the first value specifying the upper limit 
and the second value specifying the lower limit.

Table Value A property object which has two lists of (numeric or descriptive) 
values assigned, corresponding to a table with two columns.
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4. According to the Property type, set its value type to label, text, integer, boolean, etc.

List Value A property that has several (numeric or descriptive) values assigned, 
corresponding to an ordered list.

Reference Value 
(IfcCalendarDate only)

A property object which references to calendar date-type entity (day, 
month, and year).

Value type Definition

IfcAreaMeasure REAL type value of the extent of a surface. Value must be set in 
square meters, but is recalculated at export based on Area Unit 
settings (see Export Options).

IfcBoolean A defined data type of simple BOOLEAN type. Value: TRUE or FALSE.

IfcIdentifier An identifier is an alphanumeric STRING (max. 255 characters) 
which allows an individual thing to be identified. It may not provide 
natural-language meaning.

IfcInteger A defined data type of simple INTEGER type. The number of bits 
contained in the IfcInteger is unrestricted, but in practice it is 
implementation-specific.

IfcLabel A label is the term by which something may be referred to. It is a 
STRING (max. 255 characters) which represents the human-
interpretable name of something and shall have a natural-language 
meaning.

IfcLengthMeasure REAL type value of a distance. Value must be set in meters, but is 
recalculated at export based on Length Unit settings (see Export 
Options).

IfcLogical A defined data type of simple LOGICAL type. Value: TRUE, FALSE or 
UNKNOWN.

IfcMonetaryMeasure REAL type value of an amount of money without regard to its 
currency. The currency unit can be set at Currency Unit settings (see 
Export Options).

IfcPlaneAngleMeasure REAL type value of an angle in a plane. Value must be set in radians, 
but is recalculated at export based on Angle Unit settings (see 
Export Options).

IfcPositiveLengthMeasure Length measure shall be greater than zero. Value must be set in 
meters, but is recalculated at export based on Length Unit settings 
(see Export Options).

IfcRatioMeasure REAL type value of the relation between two physical quantities that 
are of the same kind. Input given in percent is expressed as a 
decimal value: e.g. 25% becomes 0.25. 

Property type Definition
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Note: All other “Measure”-type properties not listed in the above table are handled and 
exported without any unit settings.

To create a new Classification Reference, just assign it a name. Here, too, you can choose from 
the list of existing Classification Reference names defined previously for the same element type 
(click the arrow icon to access this list).

Having defined a new Property (together with its Property Set container), you can apply it to 
other elements too, not just the one you are editing. For example, if you have created the new 
data for a selected IfcWall element, you can add the new data to all elements of the same type 
as the selected one (all IfcWall entities), or to other elements of the current project/IFC model. 
Use “Add new property to Scheme Setup...” and set the level of the model hierarchy that 
contains the requested IFC Entity type(s) you would like to add the new property. For example, in 
the previous IfcWall case, choose

• “IfcBuildingElement”, if you would like to define the new property for all IfcColumns, 
IfcBeams, IfcSlab etc. besides of all IfcWalls;

• “IfcElement” to add the property to all HVAC elements (IfcDistributionElements) too,

• “IfcProduct” to also add the property to all spatial elements including IfcSpaces, 
IfcBuildingStorey, IfcBuilding and IfcSite;

• “IfcObject” to add the new property to all Assignments too; 

• the highest level “IfcObjectDefinition” to add all project elements including all IFC Type 
Product types (not only the IfcWallType)

These options will also work for new elements to be created in the future (any new IfcWalls, or 
any new element, depending on the chosen option) will automatically be assigned this data. The 
Properties that are thus created are added to IFC Scheme Setup. To understand the model 
hierarchy’s levels and their containments (and the examples mentioned before), see the next 
figure or check the hierarchy tree in the dialog of IFC Scheme Setup. 

See IFC Scheme Setup.

IfcReal A defined data type of simple REAL type. The domain of Real is all 
rational, irrational and scientific real numbers. Here the precision is 
unconstrained, but in practice it is implementation-specific.

IfcText Alphanumeric STRING of characters which is intended to be read 
and understood by a human being. It is for information purposes 
only. No character number limitation.

IfcTimeMeasure REAL type value of the duration of time periods. The time unit can 
be set at Time Unit settings (see Export Options).

IfcVolumeMeasure REAL type value of the solid content of a body. Value must be set in 
cubic meters, but is recalculated at export based on Volume Unit 
settings (see Export Options).

More Types… See the definitions at “alphabetical listing” > “Defined Types”: 
http://www.buildingsmart-tech.org/ifc/IFC2x3/TC1/html/index.htm

Value type Definition
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Newly created IFC data will appear in the defined Property Set or “Classification References” 
folder in the IFC Manager, as well as in the element Settings dialog among the listed properties. 
Assign values to the new data according to its value type. For example, a Classification Reference 
data has 7 available items (the most important ones are the “Name” and the identifier 
(“ItemReference”) of the classification reference data) for defining/editing. Such newly created 
IFC data appears with a red X in front, meaning that you can delete them at any time. If a 
Property Set no longer contains any Properties, it will be deleted from the list automatically. To 
rename a Property Set, Property or Classification Reference, click on the name, then re-write it.

Custom IFC Properties (and Property Sets) may also be created through the IFC Scheme Setup 
command (these Settings will also contain the data created by using the above-mentioned “Add 
new property to Scheme Setup...” option). These data can only be edited (deleted, renamed) 
using the IFC Scheme Setup command.

Assignments
To create a new Assignment, do the following in the IFC Manager:

1. Switch to Assignment view/definition mode by clicking the Assignments icon.

2. Select the Assignment type by clicking on the “IFC Groups”, “IFC Zones”, “IFC Systems”, 
“Actors”, “Space Occupants” or “Time Series Schedules” item.

3. Click the “New” button under the Assignments window section.

4. Select the new item, whose default name starts with “New”... and ends with the created 
Assignment type (e.g. New Group).

5. Give a (new) name to the new Assignment on the right side of the dialog in the Name 
Attribute field.

6. Edit the Attributes and/or the content of the available properties.

7. Add custom IFC data using the New Property/Classification option if needed (see above).

8. Drag and drop IFC Entities into the “New Relation” folder from the containment tree.
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Notes:

• The Entity types that can be dragged into the new Assignment depend on the Assignment 
type. For example, you can only group IfcSpaces (ARCHICAD Zones) into an IFC Zone; while 
you can group both IfcSpaces and already existing IFC Zones within a Space Occupant 
(IfcOccupant). The latter case demonstrates that the member of an Assignment can itself 
serve as an Assignment.

• In case of IFC System, spatial relation can also be assigned to the elements grouped in “New 
Relation”. Just drag and drop the required spatial element(s), such as ARCHICAD Zones 
(IfcSpace), Stories (IfcBuildingElementStorey), IFC Building and/or IFC Site, into the “New 
Spatial Relation” folder.

• If your project uses the MEP Modeler Add-On, then its defined MEP Systems can do the 
following:

• They can be classified as IFC Systems. Create a new, empty IFC System. Select it, then click 
on the MEP icon at the right (underneath the Assignment list), and choose the desired 
MEP System from the drop-down menu. All elements of the selected MEP System will 
automatically be added from the containment tree into the “New Relation” folder; the 
system’s name (Name Attribute) will be the same as the chosen MEP System.

• They can be added to an existing IFC System. Select an existing IFC System in the list, then 
choose an MEP System as described above. The existing IFC System is renamed according 
to the chosen MEP System, and all elements of that MEP System are added to the existing 
contents of the IFC System. In both cases, the system icon changes to the MEP “propeller” 
icon, indicating that an MEP System is being used. To delete MEP System elements from 
an IFC System, select the system item (which is now named after the MEP System whose 
elements you want to delete), and choose “Disconnected” from the drop-down menu of 
the MEP System options.

• Multilevel (“Sub”) hierarchy is available for IFC Group, IFC Zone and IFC System assignments. 
Sub-hierarchy (for example child systems in a parent system) can be defined easily:

• drag and drop a predefined assignment into an existing “New Relation” (or named 
relation) folder of the same type target assignment, or click “New”, with the “New 
Relation” (or named relation) folder of the “parent” assignment selected, to define a new 
“child” assignment

• a parent assignment moved into a different parent assignment becomes a “child” of that 
assignment (this is a move)

• a child assignment can be either moved or copied into a different parent assignment (to 
copy it, hold down Ctrl/Alt while dragging it)

• to make a child assignment into a parent assignment, select it and drag it outside of the 
dialog box; it will reappear in the hierarchy as a parent assignment

• If needed, define a name for the “New Relation” on the right side of the dialog in the “Name” 
Attribute field.

• Use the “Delete” (red X) button to delete a Relation or Assignment.

See IFC Assignments.
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Examples:

• Create an IfcZone named “Security Zone”, which will group together all of the project’s 
IfcSpaces that have a security function.

• Group elevators in a vertical circulation system, which can be a child system of a mechanical 
system.
ARCHICAD 20 Help 45



• Define the project architect as a person-type Actor (set at “The Actor” Attribute) who is 
responsible for the project (the assigned entity is the IfcProject).
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• Using a new Space Occupant, group together all the IfcSpaces whose owner is an 
Organization.

• Using a new Time Series Schedule, define an assignment of a weekly schedule (of the times 
when lighting is turned on and off) to IfcSpaces.
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Type Products
The IFC Manager locates and displays all the IFC Type Products that exist in the project, plus all 
the elements which refer to them. To see them, switch to the Type Products view/definition 
mode using the second icon underneath the containment tree. In the appearing list, select the 
type (e.g. IfcWallType) or style (e.g. IfcWindowStyle) or its related elements, to check and edit 
their IFC data on the right side of the IFC Manager.

As soon as it is placed, an ARCHICAD element is automatically assigned an IFC Type Product that 
corresponds to its IFC entity type (or Element Classification). For example, if an ARCHICAD Slab 
uses its default Element Classification of “Slab” (IfcSlab), then its IFC Type Product will be 
IfcSlabType. If its Classification is “Ceiling” (IfcCovering) then its type will be IfcCoveringType. 
The default name of the type is generated automatically, as described in the IFC Type Product 
section of this documentation. Based on this naming convention, several ARCHICAD/IFC 
elements will be assigned to a particular IFC Type Product. For example, ARCHICAD columns 
(IfcColumns) having identically named profiles will be assigned to a single type that is named 
after that profile. Type naming can be driven by mapping the “Name” Attribute with rules 
defined in the IFC Scheme Setup.

See IFC Type Product.

The IFC data of the resulting IFC Type Product are not editable by default; they are displayed in 
italicized gray type, and all IFC data on the right side are grayed. In this case, no new IFC data 
(e.g. custom IFC Property or Classification Reference) can be assigned to the type either. 

You may wish to edit an IFC Type Product. For example:

• change its name (which is the Name Attribute)

• define a value for an Attribute or standard Property that has no value yet

• modify existing Property data

• create a new custom Property or Classification Reference

See Creating and Editing IFC Data.

You can apply ARCHICAD data mapping rules to the IFC data of IFC Type Product elements. For 
example, generate the names of Window types (Name Attribute of IfcWindowStyle) from the 
combination of the Library Part Name, the Width and Height parameters of Window.

See IFC Scheme Setup.
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To edit the IFC Type Product, first enable it for editing: click on the “Edit/New Type” button. Then 
make the desired modifications. To revert the data of the IFC Type Product to their default 
values, click the “Reset Type” button.

Note: “Reset Type” means that all edited IFC data will revert to their original values, and the 
new data will be deleted.

It is possible to combine several IFC Type Products entities (provided they are editable, that is, 
activated using the “Edit/New Type” button) into a single IFC Type Product - for example, 
combine two IfcWindowStyle types into a single IfcWindowStyle. This combination can take the 
following forms:

• Apply an existing IFC Type Product to other types. This works for all element types except 
Doors/Windows (see below for explanation). For example, suppose you have two concrete 
Slabs of different thicknesses. By default, these will be classified as two separate IFC Type 
Products (IfcSlabType), because thickness is a significant property of slabs. But you want to 
combine them into a new, single type named “Concrete slabs.” Defining them is easy: select 
one of the IfcSlabs from its type folder and drag in into the other slab type (drag it onto the 
slab type name). This way, it will be deleted from its original location and placed into the 
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other type. Next, change the Name Attribute of the second type (which now contains two 
elements) to “Concrete slabs” (see illustration below).

• Combining doors or windows is more complicated, because some of their major parameters 
are generated from GDL data, and cannot be modified as a result of combining elements. 
Such parameters are the OperationType Attribute and the panel and lining attributes. 
Suppose you have two doors that are identical in all their data (e.g. size, panel type), but 
their Operation Types are different: one opens to the right, the other to the left. These two 
doors will be classified under two different IFC Type Products: these two Types will have the 
same name, but their “OperationType” IFC Attributes will differ. To have both doors belong 
to the same IFC Type Product, select one of the doors and place it in the other (second) type. 
As a result, a new, common type is created that uses all of the non-generated data of the 
second type (such as Name Attribute, Properties, Classification Reference, etc.). This new 
common type is the one that will be exported, and which will be assigned to both of the 
doors. This common type can be renamed and its data modified. At the same time, the two 
original types will remain as so-called linked types, and will link to the elements only data 
which is generated and which differ for each of the two doors (in this case, their 
OperationType Attributes). In other words, both doors will belong to a single type, which 
includes all of the data they have in common, but they will also maintain certain IFC data that 
were different for each and cannot be combined (see illustration below).
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The “Reset Type” option can do the following:

• When applied to a selected IFC Type Product (e.g. IfcWallType) that has been edited, the 
Type’s original data are restored (newly modified IFC data are lost), and the Type is no longer 
editable. If the Type now contains new elements as a result of combining Types, then those 
elements will return to their original locations.

• When applied to a single element (e.g. IfcWall) that has been moved into a different Type, 
that element will return to its original location where it was automatically assigned by the 
program.

For some ARCHICAD elements, automatic definition as a particular IFC Type Product is not 
always clear-cut - typically the case for HVAC elements (IfcDistributionElements). Suppose you 
have an MEP Modeler-defined Pipe element. By default, its IFC Entity classification is 
IfcFlowSegment. But its IFC Type Product definition can be even more specific (see illustration 
below). The program will automatically choose a subtype of the IfcFlowSegmentType (e.g. 
IfcPipeSegmentType). You can modify this later to be a different subtype of the 
IfcFlowSegmentType (such as IfcDuctSegmentType): use the “Change Type Product” drop-down 
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menu. (Make sure you have made the IFC Type Product editable, using the “Edit/New Type” 
function described above.)

Predefined Rules
You can assign new IFC data to selected elements based on automatic (.xml-based) rules, using 
the Apply Predefined Rule button. There are three types of such rules, based on their differing 
structures:

• “Tree list” rule: select an element from a tree-structure database to create the new data

• “Table” rule: select a row from a table to create the new data

• “Command” rule: start the rule-command to create the new data

The program contains factory-defined built-in rules (these vary depending on your localized 
version of ARCHICAD). As an example, the following table summarizes the rules that are 
contained in every language version of ARCHICAD:

Rule name Related object Rule 
type

Function New IFC 
data

Rule file

OmniClass / 
Table 11 - 
Construction 
Entities by 
Function

IfcSite, IfcBuilding 
and 
IfcBuildingStorey

Tree list Assigns a 
functional 
classification to 
IFC Building, 
IFC Site and 
ARCHICAD 
Stories based 
on this 
OmniClass 
specification

Classification 
Reference

OmniClass
.xml

OmniClass / 
Table 13 - 
Space by 
Function

IfcSpace and 
IfcSpaceType

Tree list Assigns a 
functional 
classification to 
ARCHICAD 
Zones based on 
this OmniClass 
specification

Classification 
Reference

OmniClass
.xml
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OmniClass / 
Table 21 - 
Elements

IfcElement, 
IfcBuilding
ElementType, 
IfcDistribution
ElementType, 
IfcElement
ComponentType, 
IfcFurnishing
ElementType, 
IfcTransport
ElementType, 
IfcDoorStyle, 
IfcWindowStyle 
and IfcGroup

Tree list Assigns 
category 
classification to 
building 
elements 
based on this 
OmniClass 
specification

Classification 
Reference

OmniClass
.xml

OmniClass/
Table 23 - 
Products

IfcElement, 
IfcBuilding
ElementType, 
IfcDistribution
ElementType, 
IfcElement
ComponentType, 
IfcFurnishing
ElementType, 
IfcTransport
ElementType, 
IfcDoorStyle, 
IfcWindowStyle
and IfcGroup

Tree list Assigns 
construction 
product classes 
to building 
elements 
based on this 
OmniClass 
specification

Classification 
Reference

OmniClass
.xml

Concept 
Design BIM 
2010 (US 
GSA) / Project 
Client/Owner 
and Project 
Architect

IfcProject Command Defines the 
GSA-required 
Actor-system 
items for the 
current project

Actor Concept 
Design BIM 
2010 (US 
GSA).xml

Concept 
Design BIM 
2010 (US 
GSA) / Space 
Type (Owner)

IfcSpace and 
IfcSpaceType

Table Assigns a type 
classification to 
ARCHICAD 
Zones based on 
GSA's STAR 
Space Type 
specification

Classification 
Reference

Concept 
Design BIM 
2010 (US 
GSA).xml

Rule name Related object Rule 
type

Function New IFC 
data

Rule file
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Concept 
Design BIM 
2010 (US 
GSA) / Space 
Category 
(Owner)

IfcSpace and 
IfcSpaceType

Table Assigns a 
category 
classification to 
ARCHICAD 
Zones based on 
GSA's STAR 
Space Category 
specification

Classification 
Reference

Concept 
Design BIM 
2010 (US 
GSA).xml

Concept 
Design BIM 
2010 (US 
GSA) / Space 
Category 
(BOMA)

IfcSpace and 
IfcSpaceType

Table Assigns a 
category 
classification to 
ARCHICAD 
Zones based on 
the 
requirements 
defined by the 
American 
National 
Standard 
Institute (ANSI) 
and the 
Building 
Owners 
Management 
Association 
(BOMA)

Classification 
Reference

Concept 
Design BIM 
2010 (US 
GSA).xml

Concept 
Design BIM 
2010 (US 
GSA) / Spatial 
Zone Type 
(Energy 
Analysis)

IfcZone Table Assigns a type 
classification to 
IFC Zones 
based on the 
requirements 
defined by 
ASHRAE 90.1 
Common Space 
Type

Classification 
Reference

Concept 
Design BIM 
2010 (US 
GSA).xml

Rule name Related object Rule 
type

Function New IFC 
data

Rule file
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Examples:

• Apply the “Concept Design BIM 2010 (US GSA) / Project Client/Owner and Project Architect” 
rule on the IfcProject entity (the highest level of the IFC Model hierarchy) selected in the 
containment tree of the IFC Manager. As a result, Actors (IfcActor) are created with the 
following relations: “Project Client/Owner” and “Project Architect”.

Concept 
Design BIM 
2010 (US 
GSA) / Space 
Occupant 
Classification 
and 
Properties

IfcOccupant Table Classifies 
organizations 
that occupy 
ARCHICAD 
Zones, Stories 
and IFC 
Building based 
on CDB-2010’s 
‘Occupant 
Properties 
Lookup Table’

Classification 
Reference, 
custom IFC 
Property

Concept 
Design BIM 
2010 (US 
GSA).xml

Uniclass 
tables…

IfcElement, 
IfcSpace, IfcZone, 
IfcElementType etc. 
depending on the 
chosen table of 
Uniclass standard

Tree list Assigns a 
functional or 
category 
classification to 
building or 
spatial 
elements 
based on 
different 
Uniclass tables

Classification 
Reference

Uniclass
.xml

Rule name Related object Rule 
type

Function New IFC 
data

Rule file
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• Assign a Space Occupant classification by using the “Concept Design BIM 2010 (US GSA)/
Space Occupant Classification and Properties” rule:

1. Create the new Space Occupant, then drag in the elements that belong to it (e.g. IfcSpace 
entities). 

See IFC Assignments.

2. Select the Space Occupant name in the Assignment list, then use the Apply Predefined Rule 
tool. From the dialog box, choose the “Concept Design BIM 2010 (US GSA) / Space Occupant 
Classification and Properties” rule.

3. From the table, select the desired classification item.

4. Click Apply. The Classification Reference elements and Properties are generated for the 
Space Occupant, using the values corresponding to the selected classification item.
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You can search among the rules in the databases (tree list and table) by entering any partial text.

For example, let us assign classifications to a number of roof slabs (IfcSlabs) using the “OmniClass 
/ Table 21 - Elements” rule: 

1. In the model, select the Slab elements to be classified (you can use Find & Select). Open the 
Settings dialog box and click on “Manage IFC Properties” from the Categories and Properties 
panel. Alternatively, select the corresponding IfcSlab entities from the IFC Manager 
containment tree.

2. Use the Apply Predefined Rule tool. From the dialog box, choose the “OmniClass / Table 21 - 
Elements” rule.

3. In the database Search field, enter the text “roof”.

4. From the Search result area, select the “Roof Decks, Slabs, and Sheathing” title. As a result, 
the same item will be selected in the tree list.

5. Click “Apply”. The Classification Reference is generated, with the name of “Roof Decks, Slabs, 
and Sheathing”, with an ItemReference value of “21-02 10 20 20”, and additional data 
corresponding to the OmniClass standard.
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Note:

• Once you select an element, only the applicable rules are available in the “Select Rule” 
list (for example, if you have selected IfcProject, then the “Concept Design BIM 2010 (US 
GSA) / Project Client/Owner and Project Architect” rule is available). All the non-
applicable rules are grayed.

• IfcElement includes building, distribution (MEP) and furnishing elements.

• Certain rules are not available in Settings dialogs if the rules are related to elements (for 
example, IfcBuilding, IfcBuildingStorey, IfcOccupant, IfcProject and IfcGroup) which do 
not have Settings dialogs.

• You can create and edit your own rule in .xml format. It is recommended to peruse the 
structure of an existing rule file (which may contain multiple rules), and to create a similar 
new rule by duplicating it under a different name.

• The available rules are accessible from the following folder, and the newly created rules 
should also be saved to this location: 

- On Windows:
\Users\user name\GRAPHISOFT\IFC Rules “ARCHICAD version”

- On Mac:
/Users/user name/Library/Application Support/GRAPHISOFT/IFC Rules “ARCHICAD 
version”
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IFC Scheme Setup

IFC Attributes, Properties and Classification Reference data can be stored in so-called schemes 
(.xml files).

Besides managing IFC data, you can use schemes to assign rules to IFC data, which map 
ARCHICAD property, parameter and quantity values with IFC data values. Mapping rules are also 
stored in the scheme’s .xml files.

Use IFC Scheme Setup command (File > Interoperability > IFC) to manage schemes.

Note: If you modify an IFC Scheme, then leave the dialog box, you cannot use Undo to undo 
the modifications. Therefore, before you make major changes to an IFC Scheme, you should 
first save the original scheme by exporting it in XML format.

By default, the IFC Manager and the IFC-related part of the Element Settings dialog boxes display 
scheme data. The scheme controls IFC data export, too, because the scheme enables you to 
choose whether to export only scheme data or all data - that is, scheme data plus additionally 
defined and visible custom data from the IFC management dialog boxes.

This section summarizes the functions of this command.
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Scheme Data Definition
Attribute data defined by the IFC standard are always part of the scheme. New data, in the form 
of Property and Classification Reference data, can be added to the elements in the IFC entity tree 
(hereinafter “scheme tree”) on the left side of the dialog box.

Notes:

• The Scheme tree contains all of the element types, Assignments, Type Products and their 
“parents” which are available in the IFC2x3 standard documentation and are editable in 
ARCHICAD (excluding IfcAnnotation and IfcGrid).

• The tree list can be filtered by Structural and MEP domains. For example, the Structural 
domain contains the building element (IfcBuildingElement) types (IfcBeam, IfcColumn, 
etc.) while the MEP domain contains the IfcDistribution types. The tree list can also be 
narrowed to the IFC Assignment types or IFC Spatial element types 
(IfcSpatialStructureElements: IfcSite, IfcBuilding, IfcBuildingStorey and IfcSpace).

•  Display variations of IFC element entities in the Scheme tree:

- IfcWall: entity type that can appear and is editable in IFC Manager.

- (IfcBuildingElement): “abstract supertype” entity that does not appear in IFC Manager.

• The set of Attributes is predefined, and always consists of the standard Attributes of the 
IFC (2x3) standard. No matter which scheme you import or create, those Attributes are 
always available and cannot be deleted. However, you are free to map the Attributes to 
ARCHICAD data (see later) in any combination, and this mapping can vary among 
schemes. For example, the Name Attribute might, in one scheme, contain only the 
element ID, while in another scheme it might contain the ID plus various parameters 
(such as linked Width and Height values).

To add new Property or Classification Reference data to the current Scheme shown in IFC 
Scheme Setup, do the following:

• Click the New Property/Classification button. This function is similar to the function of the 
same name found in the IFC Manager and Element Settings dialog boxes. For example: create 
an identifier-type “Ventilation Type” Property for IfcSpace entity within the Property Set 
called “ePset_SpaceVentilationCriteria”.
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• Use the “Get Current Project Settings” button to collect all the current custom (non-scheme) 
IFC Property Sets and Properties (defined in either IFC Manager or Element Settings) that are 
available in the current Project. As part of this process of collecting data, if a custom data 
already exists for at least one instance (e.g. one IfcWall element) of an IFC Entity type, then 
the custom data will appear as a data of that IFC Entity (e.g. IfcWall). Using this function, you 
can - for example - transform the custom data from an imported IFC model into Scheme data, 
and then save it in Scheme files (.xml).

• Load data from an existing scheme (.xml):

• When using Import to load a scheme file, then all existing scheme data (except Attributes) 
will be deleted, and only the data of the imported scheme will be created.

• When using Merge to load a scheme file, then that .xml file’s data are added to the 
existing scheme data. If the two merged schemes contain data with the same name and 
location (in case of Properties, the Property Set), then the original values will be retained 
in both IFC Manager and Element Settings: there is no data loss. The same is true of 
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mapping rules. Even if a given Property contains different mapping rules in the merged 
scheme than in the original, the original mapping rules will not be overridden; the new 
mapping rules are added to the originals.

Elements used to define scheme data are shown in the Scheme tree in bold type. If that element 
is at a higher level of the hierarchy (that is, a parent element such as an IfcBuildingElement), 
then all child elements belonging to it (e.g. IfcBeam, IfcColumn, IfcSlab, IfcWall, etc.) 
automatically are assigned the scheme data, but the child element will not be shown in bold 
type. This way it is easy to locate, in the tree structure, where the scheme data were added. In 
addition, scheme data assigned to a child element are shown in blue type, and the child 
element’s name is augmented by the parent type name in parentheses. The blue type also 
means that the scheme data can be modified only at the parent level (which is in black). One 
example of how this parent-child relationship can be useful: if you want to create a common 
property for all building elements, you don’t have to create it for every single building element 
type (IfcWall, IfcColumn, IfcSlab, etc.): instead, create it once at a higher level (e.g. at 
IfcBuildingElement).

A new scheme data is shown in italics if no ARCHICAD parameter/quantity (or mapping rule - see 
next section) can be applied to it.

You can rename and delete (click the red X) scheme data except Attributes. You can delete the 
entire content (mapping rules, Properties and Classification Reference) of the currently used 
Scheme with the “Clear All Scheme Settings” command.

The current content of IFC Scheme Setup can be saved in an .xml file as part of the Export 
function, and this file can then be imported (Import) or merged (Merge) into a new or existing 
project. With this workflow, you can use the current scheme data in a new project without 
redefining them.

Note: Even if you do not export the current status of the IFC Scheme Setup, the saved PLN/
ARCHICAD project will retain the IFC Scheme Setup, which will thus not be lost.

Data Mapping
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ARCHICAD properties, parameters and quantities can be assigned to the IFC data of certain IFC 
elements. Advantages of data mapping:

• You don’t have to enter those data twice (once as ARCHICAD data, and again as IFC data) 
which have a common meaning as both ARCHICAD data (e.g. Fire Rating) and IFC 
(FireRating). 

• You can save ARCHICAD data as a specific IFC model in accordance with a particular standard 
(e.g. COBie documentation or company standard), a particular collaborative workflow (e.g. 
MEP, energy analysis, FM), or the capabilities of a particular IFC model receiver application 
(e.g. Revit, Tekla, Allplan...).

Characteristics and rules of data mapping:

• The following elements of the Scheme tree, and their sub-elements (called “child” elements)  
are mappable: IfcElement (building, distribution, furnishing and transport elements), 
IfcSpace (ARCHICAD Zone), and IfcTypeObject (including all IFC Type Product entities).

• Mapping works for ‘single value’-type IFC Attributes and Properties only. Thus:

• it works for all text-, label- and logical-type properties,

• it does not work, for example, for ‘table-type’ properties,

• it does not work for Classification Reference data.

• A rule can be assigned at different levels. For example, you can apply a rule at the 
IfcBuildingElement level, which will be applicable to all of its child elements (e.g. IfcWall, 
IfcSlab, etc.). However, the rule (which appears in blue type at the child element’s level) can 
be redefined at the child level. For example, the abovementioned rule could be modified for 
the IfcWall entity.

• If a particular parameter is common to several Library Part elements, you can map its 
corresponding IFC data in just one step (see examples later).

How to create a Rule:

1. Select the scheme data item which you would like to map. Scheme data in italic type cannot 
be mapped.

2. Click on the “New Rule” button. The “Empty Rule” field appears.

3. Select a Rule Content type from the “Add Content” drop-down button:

• Parameters & Properties (as the Interactive Element Schedule)

• Library Part Parameters (as the Interactive Element Schedule)

• Static Text

4. Add fields to the rules. Fields can have types: e.g. “Thickness” is length measure, “Area” is 
area measure, “Library Part Name” is string. If a rule contains more than one field, the fields 
are always a concatenation of fields converted to a string. Conversion is based on calculation 
units (Project Preferences > Calculation Units & Rules). Fields implicitly contain filters: for 
example, the Wall's “Height” field can only be evaluated for Wall elements. “General” fields 
are listed at tools levels too and they are valid only for that specific tool.

5. Library Part Parameters can be set in two ways:

• Library Part dependent: The selected Library Part parameter will be in effect only for 
elements that contain this parameter. If the Library Part parameter was defined at the 
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Object subtype level, then the parameter mapping will take place for the child elements, 
too. For example, if we are mapping the “gs_list_cost”variable parameter of the GS Door 
Object subtype, then the mapping will be in effect for all Doors (and ifcDoors) which are 
child Library Part elements of theGS Door (such as Door, Double Door, Metal Door, etc.) 
See examples below. 

• Library Part independent: the parameter variable (e.g. “gs_list_cost”) will be in effect for 
the mapping, regardless of which Library Part it was chosen from. For example, if you 
select the “gs_list_cost” parameter of the Double Door for mapping as a Library Part 
Independent parameter, then the mapping will take place for every Door that accesses 
the “gs_list_cost” parameter. If this door parameter is used for mapping at the IfcElement 
level, then it will be mapping for all IFC entities which are child entities of the IfcElement 
and which include the “gs_list_cost” parameter (such as Furnishing elements, e.g. 
Armchair and Chair). See examples below.

Note: If the IFC Scheme Setup contains a mapping rule involving a Library Part parameter 
which is not loaded in the project, then the rule, the mapped IFC data, and the mapped IFC 
Entity data are all shown in red.

6. String-type rules can be split. Separator type, separator position and split type give you 
several ways to split a string. For example, use a split to cut out a particular fragment of a 
Library Part Name. 
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7. You can assign multiple rules to a single scheme property. This is useful, for example, if 
several tools will generate the same IFC element type. Rules will be applied in the order in 
which they appear on the user interface: the first evaluable rule wins.
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Examples:

1. Map the user-defined “Acousting Rating” property (Options > Property Manager) to the 
“AcousticRating” property defined for the IfcWall by the IFC standard scheme.

2. Map the “Fire Rating” parameter of windows to the “FireRating” property defined for the 
IfcWindow by the IFC standard scheme.

3. Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and 
“Building Material/Composite” Name.
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4. Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part 
name” + static text “-” + “Width” + static text “X” + “Height” (see splitting string-type rule, 
above). This rule will also overwrite the program’s factory default IfcDoorStyle creation rule 
(see IFC Type Product) with new IfcDoorStyle names, and will automatically create the 
corresponding doors (you can double-check the result in the IFC Manager).
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5. Define the “Cost” Property for IfcDoor as Library Part dependent parameter. For mapping, 
choose the “gs_list_cost” parameter of the “GS Door” Library Part. The mapping rule is valid 
for the Library Parts which are child elements of the “GS Door” subtype (e.g “Door”, “Double 
Door”, “Metal Door”, etc.).
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6. Define the “Cost” Property for IfcDoor as Library Part independent parameter. For mapping, 
choose the “gs_list_cost” parameter of the “Double Door”. The mapping rule is valid for all 
Library Parts which will be converted to IfcDoor and contain the “gs_list_cost” parameter (e.g 
“Door”, “Metal Door”, etc.).
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7. Define the “Cost” Property for IfcElement as Library Part independent parameter. For 
mapping, choose the “gs_list_cost” parameter of the “Double Door”. The mapping rule is 
valid for not just IfcDoor elements but all other Library Parts which will be converted to IFC 
Entities that are child element of IfcElement (e.g. IfcWindow, IfcFurnishingElement, 
IfcDistributionElement, IfcTransportElement etc.) and contain the “gs_list_cost” parameter 
(e.g “Armchair”, “Desk”, “Basin”, “Sink” etc.).
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You can see which elements have a mapping rule assigned: the property is followed by a black 
lock icon. The same lock is also shown for these elements in IFC Manager and in Element 
Settings.

Some Attribute and Property data come with a predefined mapping rule. Although these rules 
do not appear in the IFC Scheme Setup dialog box, they can be seen (if they have values) with a 
gray lock icon in the IFC Manager and Element Settings. The following chart shows these 
predefined mapping rules, which you therefore do not have to create yourself in IFC Scheme 
Setup:
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ARCHICAD 
Command

ARCHICAD 
Parameter

IFC Entity 
Types

IFC Data IFC 
Manager

Project Info Project Name IfcProject Attribute>Name visible/
editable

Project Info Project 
Description

IfcProject Attribute>Description visible/
editable

Project Info Project ID IfcProject Attribute>GlobalId (control, 
see Note later)

-

Project Info Project Status IfcProject Attribute>Phase visible/
editable

Project 
Location

Project North IfcProject Attribute>Representation
Context>TrueNorth

-

Project 
Location

Latitude IfcSite Attribute>RefLatitude visible

Project 
Location

Longitude IfcSite Attribute>RefLongitude visible

Project 
Location

Altitude IfcSite Attribute>RefAltitude visible

Project Info Site Name IfcSite Attribute>Name visible/
editable

Project Info Site ID IfcSite Attribute>Global Id (control, 
see Note later)

-

Project Info Site Description IfcSite Attribute>Description visible/
editable

Project Info Site Full Address
>Site Address1

IfcSite Attribute>SiteAddress>
AddressLines

-

Project Info Site Full Address
>Site Address2

Project Info Site Full Address
>Site Address3

Project Info Site Full Address
>Site Postal Box

IfcSite Attribute>SiteAddress>
PostalBox

-

Project Info Site Full Address
>Site City

IfcSite Attribute>SiteAddress>Town -

Project Info Site Full Address
>Site State

IfcSite Attribute>SiteAddress>Region -
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Project Info Site Full Address
>Site Postcode

IfcSite Attribute>SiteAddress>
PostalCode

-

Project Info Site Full Address
>Site Country

IfcSite Attribute>SiteAddress>
Country

-

Project Info Site Gross 
Perimeter

IfcSite BaseQuantity>GrossPerimeter -

Project Info Site Gross Area IfcSite BaseQuantity>GrossLandArea -

Project Info Building Name IfcBuilding Attribute>Name visible/
editable

Project Info Building 
Description

IfcBuilding Attribute>Description visible/
editable

Project Info Building ID IfcBuilding & 
IfcBuildingStorey

Attribute>
GlobalId (control, see Note 
later)

Project Info Contact Full 
Name>Contact 
Prefix Title

IfcPerson Attribute>PrefixTitles -

Project Info Contact Full 
Name>Contact 
Given Name

IfcPerson Attribute>GivenName -

Project Info Contact Full 
Name>Contact 
Middle Name

IfcPerson Attribute>MiddleNames -

Project Info Contact Full 
Name>Contact 
Family Name

IfcPerson Attribute>FamilyName -

Project Info Contact Full 
Name>Contact 
Suffix Title

IfcPerson Attribute>SuffixTitles -

Project Info Contact ID IfcPerson Attribute>Id -

Project Info Contact Role IfcPerson Attribute>Roles -

Project Info Contact 
Department

IfcPerson Addresses>Postal>
InternalLocation

-

Project Info Contact 
Company

IfcOrganization Attribute>Name -

ARCHICAD 
Command

ARCHICAD 
Parameter

IFC Entity 
Types

IFC Data IFC 
Manager
ARCHICAD 20 Help 73



Project Info Contact 
Company Code

IfcOrganization Attribute>Id -

Project Info Contact Full 
Address>
Contact 
Address1

IfcPerson & 
IfcOrganization

Attribute>Addresses>Postal>
AddressLines

-

Project Info Contact Full 
Address>
Contact 
Address2

Project Info Contact Full 
Address>
Contact 
Address3

Project Info Contact Full 
Address>
Contact Postal 
Box

IfcPerson & 
IfcOrganization

Attribute>Addresses>Postal>
PostalBox

-

Project Info Contact Full 
Address>
Contact City

IfcPerson & 
IfcOrganization

Attribute>Addresses>Postal>
Town

-

Project Info Contact Full 
Address>
Contact State

IfcPerson & 
IfcOrganization

Attribute>Addresses>Postal>
Region

-

Project Info Contact Full 
Address>
Contact 
Postcode

IfcPerson & 
IfcOrganization

Attribute>Addresses>Postal>
PostalCode

-

Project Info Contact Full 
Address>
Contact Country

IfcPerson & 
IfcOrganization

Attribute>Addresses>Postal>
Country

-

Project Info Contact E-mail IfcPerson & 
IfcOrganization

Attribute>Addresses>Telecom
>ElectronicMailAddress

-

Project Info Contact Phone 
Number

IfcPerson & 
IfcOrganization

Attribute>Addresses>Telecom
>TelephoneNumbers

-

Project Info Contact Fax IfcPerson & 
IfcOrganization

Attribute>Addresses>Telecom
>FacsimileNumbers

-

ARCHICAD 
Command

ARCHICAD 
Parameter

IFC Entity 
Types

IFC Data IFC 
Manager
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Project Info Contact Web IfcPerson & 
IfcOrganization

Attribute>Addresses>Telecom
>WWWHomePageURL

-

Story 
Settings

Elevation IfcBuildingStorey Attribute>Elevation visible/
editable

Zone 
Settings

Name IfcSpace Attribute>LongName visible/
editable

Zone 
Settings

Number (No) IfcSpace Attribute>Name visible/
editable

(element)>
Settings

Categories and 
Properties>ID

(IFC element 
type)

Attribute>Name visible/
editable

(element)>
Settings

Categories and 
Properties>
Structural 
Function

(IFC element 
type)

Pset_...Common>LoadBearing visible

(element)>
Settings

Categories and 
Properties
>Position

(IFC element 
type)

Pset_...Common>IsExternal visible

(element)>
Settings

Categories and 
Properties>
Renovation 
Status

(IFC element 
type)

AC_Pset_Renovation
AndPhasing>Renovation 
Status

visible

Schedule>
(element)

General
>Unique ID

(IFC element 
type)

Attribute>Tag visible/
editable

Window/
Door 
Settings

Preview and 
Positioning
>Width

IfcWindow / 
IfcDoor

Attribute>OveralWidth visible

Window/
Door 
Settings

Preview and 
Positioning
>Height

IfcWindow / 
IfcDoor

Attribute>OverallHeight visible

(automatic 
type naming 
rule)

IfcColumn Attribute>ObjectType visible/
editable

Pset_ColumnCommon
>Reference

visible/
editable

IfcColumnType Attribute>Name visible/
editable

ARCHICAD 
Command

ARCHICAD 
Parameter

IFC Entity 
Types

IFC Data IFC 
Manager
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Note: By default, ARCHICAD assigns identical GlobalID attributes to the following entities: 
IFC Project, IFC Site, IFC Building, and IFC Story. More precisely: the Global IDs will be 
identical, provided that the respective ID fields, defined at ARCHICAD’s Project Info dialog 
box (File > Info) contain identical keywords (or no value at all). However, you can alter these 
keywords in the Project Info dialog box to control whether the spatial entities have identical 
or different GlobalIDs.

Suppose you have two separate buildings (stored in two different ARCHICAD projects). You 
want both projects and both sites to share the same GlobalID; yet you want the various 
buildings on each site to have different GlobalIDs. 

To achieve this, enter the same keyword in the “Project ID” and “Site ID” fields of both 
projects. Enter different keywords for the “Building ID” fields.

(automatic 
type naming 
rule)

IfcBeam Attribute>ObjectType visible/
editable

Pset_BeamCommon
>Reference

visible/
editable

IfcBeamType Attribute>Name visible/
editable

ARCHICAD 
Command

ARCHICAD 
Parameter

IFC Entity 
Types

IFC Data IFC 
Manager
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IFC Story entities have no corresponding ID field in the Project Info dialog box. The GlobalIDs 
of IFC Story entities are derived from their Building ID. If two buildings in two different 
ARCHICAD projects have the same Building ID, then all stories of those buildings which have 
the same Story Number will have the same Global ID.

Data Synchronization 

Applying the current IFC Scheme Setup (click “Apply”) will synchronize all changes (name and 
value type modification, and data mapping) in the IFC Manager and Settings dialogs for 
properties that already exist. 

If a scheme property assigned to an IFC element type (for example IfcWall) is not yet available in 
the current project, it is not displayed in the IFC management dialogs until one instance of the 
type has been defined in the model. If you have a new empty project, you can load a scheme and 
use it as the initial IFC data.

In the IFC management dialogs, scheme data are shown with a checkbox in front of them. This 
way, it is easy to differentiate them from non-scheme, custom data, which are shown with a red 
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X in front. This also means that scheme properties cannot be deleted in either the Settings dialog 
or in IFC Manager; you can only set their values here. 

If you switch schemes (“Import” a new scheme, or create a new one after using “Clear All 
Custom Properties”), then those data of the old scheme which already have values assigned yet 
do not exist in the new scheme will be converted to custom data, and will appear in the IFC 
management dialog boxes with a red x in front of them (instead of checkbox they had in the old 
scheme). In other words, there is no loss of IFC data. 

In this case, you will find one of the IFC Export Options (in IFC Translation Setup) useful: you can 
define whether these IFC properties too should be exported (“All properties”), or just those 
which belong to the current scheme (“Current Scheme properties only”).

See Export Options.

IFC Options

The settings defined at IFC Options (File > Interoperability > IFC) also affect the way that IFC data 
are created and managed.

IFC Manager Tree View
Use this control to vary the tree view used by the IFC Manager. If the ARCHICAD model (even 
after IFC model import) contains ARCHICAD Zones (IfcSpaces) which contain Objects (such as 
MEP elements, furnishing, etc.) and Morphs, then you can switch the view of the IFC Manager’s 
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containment tree to a view (called Space Containment) which lists the Object and Morph content 
belonging to each IfcSpace.

Note: Space Containment tree view is only a visualization mode in the IFC Manager. But, if 
you would like to export this AC Zone (IfcSpace) relation of the elements, you have to check 
the “Space Containment” option for the export at the “Derived model data to export” 
options of the used IFC Translator. In this case, in the IFC model hierarchy, an element will be 
linked directly to the IfcSpace in which it is located, and will be linked only indirectly (via the 
IfcSpace) to its IfcSpace home story (IfcBuildingStorey).

See Export Options.

IFC Interface language
The language of the IFC standard/code is English, thus the default and recommended setting for 
the interface is English. In localized ARCHICAD versions, some standard IFC key words (such as IFC 
Entity, Property, Attribute names) may be shown in the local language, but this has no effect on 
the IFC export, just helps users comprehend IFC terms on the interface.

Folder-system option for Library Parts generated during import
By default, if Library Parts (e.g. ARCHICAD Objects) are generated during IFC import, they will be 
placed in the project’s Embedded Library. You can change this setting by saving the generated 
objects to a linked library. To help you keep track of Library Parts generated during IFC import, all 
such elements (whether saved to the Embedded or a Linked library) will automatically be stored 
in a subfolder, whose name is the same as the imported IFC file, plus an extension showing the 
time of import.

Hint: In case of repeated IFC Merge processes with large models, your Embedded Library 
may become very large if many Library Parts are generated; this can cause performance 
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problems. In this case, you should save the generated Library Parts to a linked library 
instead.

Notes:

• Make sure that the target folder is write-enabled at the time of import. If it is not, the 
import process will fail.

• In Teamwork, the Linked Library option is not available; generated Library Parts are saved 
to the Embedded Library.

Express Data Manager (EDM) path
The EDM (Express Data Manager) toolkit is the engine which creates an ARCHICAD model from 
the imported IFC model, and which also creates an IFC file out of the exported ARCHICAD model. 
The default engine is the recommended one, but you can use the Redefine option here to 
modify it as needed.

Find and Select Elements by IFC Data

Use the Find & Select function to locate and select elements that match criteria based on the 
elements’ IFC data, Attributes, Properties and Classification References.

1. In the Find & Select dialog box (Edit > Find & Select), choose “IFC Properties” from the “Add” 
pop-up list to access additional criteria.

2. The Select IFC Properties dialog box appears.

Note: This dialog box is also available when adding Criteria and Fields to an Interactive 
Scheme Schedule.

All IFC data added to project elements (derived and checked in Element Settings dialog box 
or IFC Manager) are listed here. (This data will therefore be exported if the project is saved in 
IFC format).

3. You may narrow the entire available IFC data list:

• to include all IFC Scheme Properties (as opposed to just those used in the Project). For 
example, you may want to define a Find & Select criteria set that includes properties (e.g. 
Fire Rating) which may not yet exist in your project;

• to available IFC data of a chosen IFC Type; and/or

• to searched IFC data by typing any text string in the “Filter” list field.

Note: In filtering by IFC Type, the “All” option means all IFC Element Types which exist in the 
current project (i.e., is visible in the IFC Manager).
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4. Click on the listed IFC data that you want to use as search criteria in the Find & Select dialog 
box. Multiselection is available. If you select a Property Set in the list, then all of the 
Properties it contains are added to the criteria. Similarly, if you select an Attributes folder or 
a Classification References folder, then all the items contained in the folder are added to the 
criteria.

5. Click “Add as Criteria” to return to the Find & Select dialog box. All selected IFC data is now 
added as search criteria.

6. Define operators and values for the criteria according to their type (label, integer, boolean 
etc.). (You may get values for the IFC data criteria from the model by applying the Pick Up 
Settings and Copy Settings tools to the owner element of the same IFC data type.)

7. Click the “Plus” button to execute the Find & Select function.
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You can also use Find & Select to search by IFC Type. Its criteria list is divided between all types 
available in the project (above the line) and all types that can be displayed and modeled in 
ARCHICAD (below the line). This means that you can create so-called Criteria Sets even for 
elements that have not yet actually be placed in the current project.

Note: IFC Type is also determined by Element Classification. For example, if in a given view, 
and with the Element Type criterion set to “All Types”, you search for IfcBeam as the IFC 
Type, then the program will select all of the Beam elements visible in the current view whose 
Element Classification is set to their default value of “Beam”, plus all other elements created 
with other tools that have been assigned “Beam” as their Element Classification (such as a 
Beam drawn using the Wall tool).

The IFC Type’s criteria list includes all so-called “parent” element type (these are collector 
entities that are above the other elements in the IFC entity hierarchy). For example, if your sole 
criterion is IfcBuilding, you can, with a single click, select just the building elements (IfcBeam, 
IfcColumn, IfcSlab) from among all the elements in the current view - while leaving out the other 
elements (like MEP and furnishings).

In addition to IFC Type, you can also use Find & Select to search for IFC Assignments and IFC Type 
Product entities assigned to ARCHICAD elements.

The advantage of searching by Assignment is that you can, for example, find elements belonging 
to a particular Assignment, or those that have not yet been grouped into Assignments. The 
following illustrations are examples of Find & Select possibilities:

1. Find all elements that are members of any Assignment.

2. Find all elements of a particular IFC System.

3. Find all ARCHICAD Zones that have not yet been grouped into an IFC Zone.
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The following illustrates how to use IFC Type Product as a search criterion:

1. Find all elements that belong to a particular IFC Type Product,

2. Find all elements that do not belong to a particular IFC Type Product.

Note: The “Pick Up Settings” function does not work for IFC Assignment and IFC Type 
Product criteria.
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Scheduling Elements with IFC Data

Use ARCHICAD’s Interactive Element Schedule to list IFC data assigned to current project 
elements.

The fastest way to create a new Element Schedule is to use the New Schedule command, 
available if you right-click the “Element” item in the Navigator.

As with the Find & Select function (see previous section), you can use IFC data as element 
criteria when creating an Interactive Schedule. 

In the Schedule Field, you can use the following IFC data:

• IFC Type (use the Add Fields button from the list of General parameters). The schedule will 
list the IFC equivalent of the Element Classification. 

• IFC Assignment, e.g. IFC Group. 

See IFC Assignments.

• IFC Type Product, e.g. IfcColumnType. 

See IFC Type Product.

• ARCHICAD IFC ID (the Globalid IFC attribute automatically assigned by ARCHICAD to each 
element)

• External IFC ID (the Globalid IFC attribute assigned to each element upon IFC import)

See Import Functions.

• Any other IFC data (Attribute, Property and Classification Reference) that exist in the project 
(use the IFC Properties button from the Add Fields pop-up).

When you choose these criteria, the process is similar to that described under Find & Select.

See Find and Select Elements by IFC Data.

Here, too, multiselection is available; and if you select a Property Set from the list, then all of the 
Properties it contains are added as fields.
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Field selection for the new schedule is also simple. Use “IFC Properties” to open the dialog 
containing the available IFC data. “IFC Type”, “IFC Assignment”, “IFC Type Product” and the IFC ID 
items are available under “General” parameters. After you click “OK” in the Scheme Settings 
dialog, the program automatically generates a schedule with the Field elements and their values.

Examples:

• List all the columns and beams, together with their custom Surface materials, profiles and IFC 
Properties, that have been merged in IFC form from a structural model.

• If you choose “IFC Assignment” as the parameter for Schedule Field, then the table will list 
(in non-editable form) all those IFC Assignments (their named branch) to which the element 
belongs. If an element has multiple Assignments, all of them will be listed, separated by a “;”.

• If you wish to list an element’s “IFC Type Product” data, then the Schedule table will generate 
two columns: The “IFC Type Product - Type” (e.g. ‘IfcWallType’ and “IFC Type Product - 
Name”) (the Name Attribute of the IFC Type Product).
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Export Functions
There are three export functions to choose from:

• Save as (File menu): exports the entire current ARCHICAD project or just its filtered content 
to an entirely new IFC file.

• Merge to IFC Model (File > Interoperability > IFC ): enables you to merge only certain IFC 
elements (model filtering) or, alternatively, the entire content of the current ARCHICAD 
project into an existing (unopened) IFC file. For example, use this command if you want to 
add selected content from an ARCHICAD model to an IFC file from another discipline (MEP-
system, structural model etc.) that was created for the same project.

For example, this illustration shows the result of merging an ARCHICAD model into an 
existing file that contains an MEP model.

Note: In case of Merge to IFC Model, the content of the existing IFC file is protected: merging 
a file to IFC will only add to it, without replacing any of its elements. This means that if an 
element to be merged has the same IFC GlobalId Attribute (in the ARCHICAD model also 
called ARCHICAD IFC ID) as an existing element in the IFC file, then the ARCHICAD element 
will be merged using a new IFC GlobalId Attribute. Thus, elements will never be overwritten 
as a result of a merge. This also means that the Merge to IFC Model command is not suitable 
for merging changes from one version of an IFC file to another version of the same file!

• Publisher (Document menu): publishes views to IFC formats. Views can be published to all of 
the IFC formats. For each Publisher item, you can vary the Translator, so that the view 
content can be customized to the needs of the recipient, creating the desired output with a 
single click.
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Set up a two different 3D views of the model: in one, display only the load-bearing structures 
(using layer settings and the “Core of Load-Bearing Elements Only” option in Partial Structure 
Display). Choose the Tekla Structures translator for this publisher set for model sharing - e.g. 
with a structural engineer who uses Tekla Structures. In the other view, display the entire 
model, and use a different translator for the mechanical engineer. Click “Publish” to output 
both selected items.

Publisher is also useful when exporting views by story, if the recipient program requires this. 
For example, a structural engineer might calculate and design slabs of a story as plates with 
planar analysis applications.

During all export processes, IFC models will be generated from ARCHICAD elements by mapping 
them according to the elements’ default type, or according to the elements’ user-defined 
classification.

The export processes are always assisted by predefined translators, whose default settings you 
can modify or overwrite as you go.

See Import/Export Settings.
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Filtering elements for export can be carried out using the following criteria:

• The selected elements in the current view.

• The visible elements, based on display settings (Layers, Partial Structure display, etc.) in the 
current view (the view that was open when you issued the Save as command).

• The entire model with the current view’s display setting, regardless of any selection or layer 
settings.

Notes:

• In order to export 2D drawing-type elements, annotation element or Grid elements, it is 
not enough to meet the criteria of the filters listed above (e.g. export based on selected 
or visible elements); you must also specifically enable the export of these elements in the 
“Import/Export Filter Options” of the translator being used.

• Publisher always uses the ‘visible’ element export mode, independently of the filtering 
type status of the applied translator. That means Publisher exports always models based 
on the current exporter view settings.

The filter to be applied may depend upon any of the following:

• the default filters in the translator,

• any manual resetting of the filters using the Export pop-up in the export dialog box (this 
allows you to filter only the elements in the currently open view),

• any further filtering set up in the Model Filter (e.g. all model elements, or all visible 
elements, or all selected columns).

See Model Filter.

The basic steps involved in Save as and Merge to IFC Model are as follows:
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Step 1: Choose IFC File Format to which to Export (Save as type)
From the “Save as type” field, choose the desired IFC file format for export.

See File Types.

Step 2: Choose Translator
Exporting IFC elements occurs in conformity with the settings of the selected translator. Use the 
drop-down list to choose among the predefined or user-defined translators. The default 
translator for export from ARCHICAD is shown by default. Use the Settings button to edit a 
translator’s settings, or to create a new translator.

See Import/Export Settings for details on these settings.

To quickly adjust the element filters for the current export - without modifying the translator’s 
default settings - use the Export option in the export dialog box, or the Model Filter function.

See Model Filter.

Step 3: Modify Element Filters as Needed (Export)
Possible filters:

• Selected elements only (available only if elements have been selected)

Elements selected in the current view (the view that was open when you issued the export 
command) will be exported.

• Entire project 

The entire model (regardless of any selection, and regardless of the elements’ show/hide 
status) will be exported.

• Visible elements (on all stories)

The visible elements in the current view will be exported, regardless of any selection. 
(“Visible” means all elements that are set to be displayed (due to layer settings, model view 
options, partial structure display, etc.).)

Note: If you issue the export command from Floor Plan view (“Visible elements (on all 
stories)”) means all elements currently displayed on every story of the project.

• All elements on current story (available only if Floor Plan is open)

All elements (regardless of any selection, and regardless of the elements’ show/hide status) 
on the current story of the Floor Plan will be exported.

• Visible elements on current story (available only if Floor Plan is open)

All elements (regardless of any selection) that are visible on the current story of the Floor 
Plan will be exported.

Step 4: Model Filter (use as needed)
See Model Filter.
ARCHICAD 20 Help 89



Step 5: File Name
Use the “File name” field to define (Save as) or choose (Merge to IFC Model) the file name you 
wish to export, then click “Save”.

Step 6: Export
Click “Save” (Save as) or “Open” (Merge to IFC Model) to start the export process.

Hint: After exporting an IFC model, it is good practice to check the IFC model in an IFC viewer (or 
in ARCHICAD by reopening the IFC file). There are many free IFC viewers on the market that can 
be readily downloaded, including:

• DDS-CAD Viewer: http://www.dds-cad.net

• Solibri Model Viewer: http://www.solibri.com

• Tekla BIMsight: http://www.teklabimsight.com
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Import Functions
There are four import functions to choose from:

• Open (File): opens the entire model or filtered parts of an IFC file as a new project. 
ARCHICAD will transform the imported elements (e.g. IfcWall) into the corresponding 
ARCHICAD elements (e.g. Wall).

• Merge (File > Interoperability): is available only in Floor Plan view, and inserts a received IFC 
model in whole or in part into a running ARCHICAD project. Merge preserves your running 
project, without overwriting its data (this is the “Reference model” concept). So the program 
always automatically generates new IFC GlobalId (ARCHICAD IFC ID) values for all imported 
elements to avoid overwriting the IFC GlobalIDs of the host project. However, even in this 
“Reference model”, the merged elements are real ARCHICAD elements based on the IFC-
ARCHICAD mapping convention. Of course, for the purposes of listing and searching, the 
import process will retain the elements’ original GlobalId values, in the form of a parameter 
called “External IFC ID”.

See IFC Element Types.

The process of merging an IFC file is similar to merging another PLN file to ARCHICAD: for 
example, you will define how to place the incoming stories into the existing story structure.

• Detect IFC Model Changes (File > Interoperability > IFC): detects the geometric differences 
between two versions (IFC files) of a single model, and merges the modifications (new, 
deleted and modified elements) only into the currently running project.

• Update with IFC Model (File > Interoperability > IFC): updates the current project content 
with an IFC model (an IFC file). Use this if the project and the IFC file contain elements in 
common, and if you want to add to or modify the project elements’ data using IFC properties. 
“Elements in common” are those whose GlobalId Attribute is the same in both the host 
project and the imported IFC model. “Properties” are IFC Attribute, IFC Property and IFC 
Classification Reference data. Geometry data (size, color, layer) will not be updated or 
modified. Using this command, one or more of the following functions can be carried out:

• Merge new properties from IFC: IFC data (Attribute, Property and Classification 
Reference) which do not yet exist in the host project will be added to elements in 
common. For example: You export your Zones in IFC format to a Zone management 
application. The application adds new data to your Zones and sends back a new IFC file. 
Now use this function to add the new data to your existing Zones (provided, of course, 
that the application has retained the Zones’ GlobalId attributes.) 

• Override existing project properties: For elements in common, the project data will be 
modified by the corresponding data values from the merged IFC file. Corresponding data: 
IFC Property data must have the same Property name and Property Set name; Attribute 
and Classification Reference must have the same name.

- Note: This is a full override: all values for data items having the same name will be 
modified; the original project values will be overridden.

• Remove project properties that do not exist in IFC: For elements in common, those 
project data will be removed which do not exist in the merged IFC file.

• Merge new IFC model elements: Unlike the functions above, this one is not concerned 
with specific IFC data. Here, the elements which exist only in the merged IFC file are 
ARCHICAD 20 Help 91



added to the ARCHICAD project. The newly added elements are inserted together with all 
of their IFC data.

- Note: The properties of locked existing project elements cannot be overridden or 
updated.

Hint: To narrow the set of “elements in common”, you can use the Model Filter when 
merging the IFC file - that is, use a Translator that has an active Model Filter (see IFC 
Translation Setup > Import Options > Show Model Filter on import). This way, for example, 
you can update just the Zone (IfcSpace) properties, or the properties of all elements on a 
particular story (IfcBuildingStorey).

See Model Filter.

Note: All import functions (except the Open command) can be canceled with the Undo 
function. Nevertheless, it is recommended that you save the ARCHICAD file before you 
merge an IFC file.

Since the Detect IFC Model Changes command is more complex than the other three and has 
other functions apart from import (e.g. managing and displaying changes), it is discussed in a 
separate chapter.

See Change Detection.

The current chapter discusses the Open, Merge and Update with IFC Model commands.

Notes:

• Only the Open process will retain the original IFC GlobalId Attributes of the imported 
model elements. However, if the opened IFC file is saved as an ARCHICAD PLN, and then 
hotlinked, ARCHICAD will change the IFC GlobalId values, to protect the elements of the 
host project (again, in line with the Reference model concept).

• 2D drawing, annotation (IfcAnnotation), and Grid (IfcGridAxis) elements are merged from 
an IFC file only if their import is enabled in the “Import/Export Filter Options” settings of 
the applied IFC Translator.

• When importing a model, you may find that some elements - though defined as IfcWall, 
IfcSlab, etc. - will be imported to ARCHICAD as Objects (and not as Walls, Slabs, etc.). The 
reason is that their geometric representation is set to the simple “face-based surface” or 
“boundary representation” (BREP). This means that, apart from the element geometry, 
the element does not include information such as its reference axis. In the absence of 
such information, ARCHICAD interprets such “simplified” elements as Objects (with Wall-, 
Slab-, etc. subtype). Nevertheless, these elements will appear as “Wall” or “Slab” in the 
IFC settings interface in ARCHICAD or in an IFC Viewer, which display element types. With 
IFC viewers, you should check these elements’ geometric representations, such as face-
based surface (ARCHICAD Object) or extruded (ARCHICAD Wall, Slab, etc.). In some cases, 
ARCHICAD’s import engine is able to handle imported BREP elements and attempts to 
convert them into real ARCHICAD elements, primarily Slabs or Roofs.

• At IFC model import, a folder-system can be set for the generated Library Parts 
(embedded library, linked library and .lcf). This allows you to control location of the newly 
created objects. 

See IFC Options.
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In all import types, both element geometry and IFC data are imported. Some of these are stored 
with the element as ARCHICAD Attributes, others as IFC Attributes, as standard or custom IFC 
Properties and Classification Reference items. Also, all IFC Container, IFC Type Product and IFC 
Assignment entities will be imported with their full data in ARCHICAD.

See IFC Data Types.

During the Open process, the IFC model hierarchy is generated with all of its data (Attributes and 
Properties), based on the imported IFC model. In contrast, the Merge-type processes (Merge, 
Detect IFC Model Changes, and Update with IFC Model) take place based on the reference model 
concept, so that the existing open project is protected; its IfcProject, IfcSite, IfcBuilding and 
IfcBuildingStorey (Story) data derive from the existing project and are not overwritten by the 
corresponding data of the incoming model.

See IFC Model Hierarchy.

Imported IFC data can be checked in the Settings dialogs of the imported elements and in the IFC 
Manager. Find & Select, Interactive Element Schedule and Labeling also work for/with the 
imported IFC data.

See Working with IFC Data.

Imported elements can be placed onto particular layers in ARCHICAD, as defined in the applied 
IFC translator. For example, in the case of a Merge, you can place the imported IFC model 
elements onto one or more new layers, keeping them separate from the elements of the running 
project.

Follow these steps to import IFC data using the Open, Merge and Update with IFC Model 
processes.

Step 1: Choose the IFC File Format
Choose the IFC file format.
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Step 2: Choose File to Import

Step 3: Choose Translator
Importing IFC elements occurs in conformity with the settings of the selected translator. Use the 
drop-down list to choose among the predefined or user-defined translators. The default 
translator for import to ARCHICAD is shown by default. Use the Settings button to edit a 
translator’s settings, or to create a new translator.

See Import/Export Settings.

Click “Open” to import the IFC model. Additional steps follow, depending on the type of 
imported model and the chosen import method.

Step 4: Building or Site Selection
If the IFC file contains multiple IfcBuildings and/or IfcSites, then a Building/Site Selection dialog 
appears. In case of a building, you have to choose a building since the import process can import 
only one building at a time (see the next figure).

On the left of this selection dialog, view the site and building hierarchy in the tree structure. At 
right, information is shown on each selected building. If the “Import all Site geometry” option is 
not enabled, then the selected IfcBuilding will be imported with only the IfcSite geometry which 
is assigned to the building. To import the entire site model, regardless of the chosen building, 
activate the “Import all Site geometry” option.

Step 5: Filtering Input Content
This is an optional setting that is available if the “Show Model Filter on import” option is 
activated on the translator’s Import Options tab page. The Model Filter allows you to ignore the 
translator’s default settings and to apply custom element filters to the current import process 
(e.g. import just IfcColumns, or just the Ground Floor elements, or just the structural elements 
94 ARCHICAD 20 Help



(IfcBuildingElement) or MEP elements (IfcDistributionElement), or just elements, such as certain 
IfcColumns, selected from the model hierarchy, or any selection achieved by using filters – such 
as certain columns on the first floor only).

See Model Filter.

Step 6: Story Matching (only at Merge)
When using Merge IFC (as when merging a PLN), you must define the story of the receiving 
project on which to place the story structure of the incoming IFC data. (The physical height and 
relative elevations of the elements will not change.) In the appearing “Match Stories” dialog box, 
“Current Story” refers to the story of the running project which was active when you issued the 
Merge command. From the pop-up menu, choose the story of the incoming IFC project which 
should be placed onto the current story. In the list, each story of the IFC model is shown with its 
own elevation in parentheses. If you want to change the physical height of the imported story 
structure, you can do so by entering a positive or negative value in the Elevation offset field. By 
default (and this is recommended), the Elevation offset value is the absolute difference between 
the elevation values of the chosen IFC model story and the current ARCHICAD story. A story’s 
absolute elevation is shown in parentheses after its story name.

The result of merging stories: the story structure of the original project remains intact (it is not 
overwritten by the newly merged content), and new stories are created only above or below the 
existing ones (according to the IFC model).

Note: If the imported IFC file contains only a single story, then the story chooser option is 
grayed, and that IFC story is used. During Merge, the elements will end up in the right place if 
you issue the Merge command from the Floor Plan view of the ARCHICAD story that 
corresponds to the right position, if such a story exists. If not, and if the current ARCHICAD 
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story is in a different position, then use the default Elevation offset value (the difference 
between the stories’ absolute elevations).
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Change Detection
The Detect IFC Model Changes function (File > Interoperability > IFC) detects the geometric 
differences between two versions of a single model that has been exported as IFC - that is, it 
compares two IFC files that are two versions of the same project. The elements affected by the 
modifications are generated and merged into the currently running project (that project can also 
be an empty one). Modifications can be viewed and managed using ARCHICAD’s Mark-Up tool in 
both 2D and 3D views.

Naturally, you can restrict the change detection to only a part of the model (for example, to 
elements on the ground floor) or to particular element types (for example, just columns). Since 
the two file versions differ by timestamp, the following geometric differences are detected:

• New Elements: elements created in the newer version that did not exist in the earlier 
version.

• Deleted Elements: elements that existed in the earlier version but were deleted from the 
newer version.
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• Modified Elements: elements that have been modified (in their position and/or size) from 
one version to the next.

Notes:
• It is important that the two IFC files being compared originate from a single application and a 

single project, because the comparison process (more specifically, the pairing of the modified 
elements) is based upon the elements’ GlobalId numbers in the IFC model. If there are no 
identical IFC GlobalIds in the two versions, then all elements will be considered either new or 
deleted.

• It is also important that you correctly identify which IFC file is the older project version and 
which the newer version.

• The change detection applies only to 3D elements - not to any of the 2D IfcAnnotation (lines, 
texts, fills etc.) and IfcGridAxis elements that may be stored in the IFC file.

• Since the changes are merged into the current ARCHICAD project, we recommend that you 
save the ARCHICAD project before using the Detect IFC Model Changes command.

Hints: 
• Independently of any model exchange workflow with other applications, the Detect IFC 

Model Changes function can also be used to compare two versions of an ARCHICAD project: 
you must have saved both versions of the project as IFC files. This works if the export process 
is set to store the GlobalId numbers in each of the two versions.

• You can use other Mark-Up functions (e.g. Comment, snapshot) to manage changes, which 
can be used as part of a BCF-based workflow. 

See Export Options of IFC Translators.

Follow these steps to compare two IFC files:

Step 1: Browse for the two IFC Files
Start the Detect IFC Model Changes command. Use the Browse buttons to locate and select the 
IFC model, noting the order in which the two files were created (“Older” and “Newer”). Keeping 
track of the versions is crucial to ensure the proper detection and interpretation of the changes.
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Step 2: Choose Translator
From the pop-up list, choose an IFC Translator.

The Translator shown is the one defined as the default for IFC import. Translator settings which 
will be applied in this process include:

• the “IFC Domain” and “Structural function” Import/Export Filter Options (these are the 
default filters for comparing elements); and

• the Material Conversion (Import Options) settings.

Assigning the elements to layers is not governed by any setting in the translator, but rather set in 
a later step (see Step 4).

See Import/Export Settings.

Step 3: Define the Element Types to be Compared
Although the translator chosen in Step 2 defines the default filters to be used for the elements 
being compared, you can use the next dialog box to further limit the model. In fact, you can 
define entirely different filters or customize them.

Thus, use this dialog box to optionally narrow the set of elements to be compared in the two 
files:
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• Filtering by IFC Domain: use one of the predefined domain filters to define the element 
types to be compared. The default value here is the IFC Domain (Import/Export Filter 
Options) setting of the translator chosen above. “All element types” will compare all 
elements from the two files. The “Structural” or “HVAC” domains will consider only 
IfcBuildingElements (IfcWall, IfcBeam, IfcSlab etc.) or IfcDistributionElements, respectively. 
The “Custom” domain filter can be created using the Options button – e.g., you can consider 
just beams (IfcBeam) or just columns (IfcColumn).

• Filtering by Structural Function: if the IFC files to be compared include elements classified by 
Structural Function (that is, LoadBearing IFC Property is assigned to elements), then use this 
setting to filter load-bearing elements, for example as part of a structural-architectural data 
exchange. The default value here is the Structural function (Import/Export Filter Options) 
setting of the translator chosen above.

Note: You should use this filtering option only if you are certain that your fellow 
professional, with whom you are exchanging data, is using and able to export the 
LoadBearing IFC Property.

• Filtering by Story/Layer/Owner/Element type: the elements of the two files are listed in a 
tree structure under (IFC) Element Type. The initial filtering is carried out by the IFC Domain 
and Structural Function filters set above; this part of the dialog box enables further fine-
tuning of the filter, by checking or unchecking element types one by one. Elements can be 
grouped in this structure, to make it easier to gain an overview. For example, you can group 
the element types by Story, by Layer, or by both Story and Layer. For example, you can 
combine an element filter with a story filter to compare just columns on the floor plan.

Step 4: Differentiate Between Elements from Each Version
Based on the filters you have set up, a list will summarize the detected changes, by number and 
by the type of the change. These changes will be merged to ARCHICAD as Mark-Up Entries. To be 
able to differentiate between elements from each of the two versions, the affected elements will 
be placed on a separate layer when they are merged into the current ARCHICAD project. 
Naturally, you can define a different layer name for this purpose than the layer shown by default.
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Step 5: Merge Changes to the Project
Click “Merge” to send the changes to the project with Mark-Up Entries. Only the detected 
changes of the filtered and compared elements (see Step 3) will be merged into the project and 
placed to the selected two different layers (see Step 4).

Step 6: Story Matching
When merging the differences between the IFC file versions, you must define the story of the 
receiving project on which to place the story structure of the incoming IFC data.

If the two files have differing story structures, you must do the story matching for each of them.

See Story Matching at Import Functions.

Step 7: Use Mark-Up Tool
The Mark-Up Palette appears automatically and lists the changes as Mark-Up Entries, using three 
mark-up styles: “New”, “Deleted” and “Modified Elements”. Thus, the elements are easily 
distinguishable on screen according to their specific style. Entries can be sorted by Style and by 
their Floor Plan View.

Elements from the two compared models are categorized separately by the Mark-Up function:

• Elements from the older version (that is, the Deleted and Modified elements from the older 
version) are shown as “Correction”

• Elements from the newer version (that is, the New and Modified elements from the newer 
version) are shown as “Highlighted”

Each of these categories uses different Mark-Up Styles and their elements can be edited 
accordingly.
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Functions on the Mark-Up palette enable you to view, select or zoom to the elements in the 
entries.

Hint: The default colors for marking different change types can be modified in the Mark-Up 
Styles palette (Options > Element Attributes).

Since the elements from each of the two model versions are categorized separately in Mark-Up, 
each Modified element entry contains a pair of elements: one element from the older model 
version, shown as “Correction”, and a newer-version element, shown as “Highlighted.” Their 
different colors make it easy to distinguish them. Moreover, each element in the pair is placed on 
a different layer (see Step 4). You can check any element’s layer by reading its Info Tag, which 
appears when you hover your cursor over any element.

Elements detected as changed become part of the project and are placed on separate layers 
depending on their version (older or newer). To each of these elements, the Mark-Up function 
assigns these elements a category: either “New”, “Deleted” or “Modified”.

Now what can you do with them?

• Deleted Element: You can leave it in as part of the project (placing it on a separate layer); or 
you can delete it together with its Mark-Up Entry, by clicking “Delete Entry” in the Mark-Up 
Palette. You can also use “Delete Entry” without deleting the elements in the Entry.

• New Element: Since it has a Highlighted status, deleting its entry will not delete the element, 
it will just lose its Highlighted status. Then you can use the element as you wish (or even 
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delete it from the project). A New element will be deleted together with its Mark-Up Entry 
only if you first remove its Highlighted status (click the “Remove Highlight” button).

• Modified Element: This pair of elements includes one each that is “Old” and “New”, with the 
same options as described above for “Deleted” and “New” elements. That is, if you do a 
Delete Entry, the older-version element can be either retained or deleted, while the newer-
version element will remain intact, while losing its Highlighted status.

Hint: If you delete a Mark-Up Entry by mistake, use Undo.
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Import/Export Settings
Importing and exporting model data using IFC takes place according to the settings of the 
translator you are using. ARCHICAD provides predefined, factory-default IFC Translators, but you 
can define your own. IFC Translation Setup command (File > Interoperability > IFC) allows you 
to view or modify translator settings, or to create new translators. The following is a description 
of the settings found in the IFC Translation Setup dialog box:

Available Translators
By default, you will see the predefined translators (offered for structural, MEP and general 
connections) shipped with ARCHICAD. Any newly created translators will also be listed here. The 
program’s default translators for import and export are distinguished by a blue arrow symbol; 
these default translators will be shown when you execute the import or export commands. You 
can define any selected translator as the default for export and/or import by choosing the 
“Default for” symbol in the column marked with the blue arrow.

There are two ways to create a new translator:

• “Create New” creates a new translator (by duplicating the “General” translator) with a given 
name and on a given place.

• “Duplicate” duplicates the translator selected in the list. With “Rename”, a custom name can 
be set for the copied translator.
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In both cases the new translator contains the same settings as the one duplicated, but you are 
free to change any of the settings:

• Set whether the translator should be available for use with IFC model import, export, or 
both: choose the corresponding “Use for” symbol in the column marked with the green 
arrow. This way, the translator will be available in the pop-up translator list in the 
corresponding import (Open, Merge, etc.) dialog box and or export (e.g. Save as) dialog box.

• Use the Description field to add an optional descriptive text for this translator.

• Modify the translator’s Import and Export settings as needed (see below).

Note: A translator that is locked cannot be modified; the settings described below cannot be 
changed in this case. However, if you duplicate a locked translator, you can change its 
settings.

• Modifications to translator settings take effect when you click Save Settings & Close. Each 
translator is stored in an .xml file; these files can be exchanged among ARCHICAD users, and 
imported into ARCHICAD projects using the “Browse” option. The “Location” field under the 
translator list shows the path of the selected translator’s .xml file.

• If you want a customized translator to revert to its original, factory-default settings, first find 
the original translator file here:

• \Program Files\GRAPHISOFT\ARCHICAD version\Defaults\IFC Translators folder (Windows 
platform), or

• /Applications/GRAPHISOFT/ARCHICAD version/Defaults/IFC Translators folder (Mac 
platform),

then use this file to overwrite the current translator, found at the place given in the Location 
field.

•  Use Delete to remove a translator you don’t need from this list.
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Import/Export Filter Options

• IFC Domain

Displays the default element-type filter for the selected translator. Use the IFC Domain to 
filter according to the following criteria for IFC import and export: “All” will include all 
elements from the model; “Structural” will include only the structural building elements 
(IfcBuildingElement); “HVAC” will include only the mechanical elements 
(IfcDistributionElement). To see the exact composition of each Domain filter, click “Options”; 
modifying these options will create a “Custom” filter.

For example, you may create a Custom filter to export AC Zones (IfcSpace) as well as building 
elements, but nothing else.
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• Structural Function

Use this as an additional (element-level) filter for export and import purposes, which will 
take into account the elements’ Structural Function classification at export and 
“LoadBearing” IFC Property at import.

• The Structural Function filter has no effect on ARCHICAD Zones (IfcSpaces). In other 
words, Zones will be exported if they are available for the chosen exported method 
(Visible elements, Selected elements only or Entire project.) Thus, Zones can be exported 
together with Load-Bearing building elements, which can be useful, since Zones provide 
important input data for the structural design (e.g. for load definition). 

• “All elements” will not take the elements’ Structural Function classification into account.

• Filtering by Structural Function works differently for IFC Import and IFC Export: 

- At IFC Import, the filter considers the “LoadBearing” IFC property. “Load-Bearing 
elements only” means that only those elements whose IFC Property “LoadBearing 
Element” has a “True” value will be imported from the IFC file to ARCHICAD. Although 
IfcPile and IfcFooting elements have no “LoadBearing” property, they are always 
handled as “LoadBearing True” elements by definition (by buildingSMART).

- At IFC Export, the filter considers the ARCHICAD “Structural Function” classification. 
“Load-Bearing elements only” means that only those elements classified as “Load-
Bearing Element” (plus ARCHICAD Zones) will be exported from ARCHICAD to IFC.
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Notes: 

- If no Structural Function classification has taken place in the ARCHICAD project, or if 
you have not finished the classifying process in ARCHICAD, then you should choose “All 
Elements” here: either of the other two settings (“Load-Bearing elements only” or 
“Non-Load-Bearing elements only”) can result an empty IFC file, or one that is missing 
elements you might need.

- The default Import/Export Filter Options set here can be overwritten during the 
export/import process using the Model Filter options.

See Model Filter.

- IfcPile and IfcFooting entities are load-bearing structural elements by definition, 
although they have no "LoadBearing" property in the standard IFC scheme. They are 
always handled as load-bearing elements at both export/import.

• Convert IFC Annotations and ARCHICAD 2D elements

If you check this box, the export process of the following 2D elements is allowed: Texts, 
Labels, Fills, Lines, Arcs, Circles, Polylines, Splines and all dimension types.

However, the inclusion of 2D elements in the exported file is also affected by the “Export” 
option set in the export IFC dialog boxes.

- If a 3D view is currently active, the 2D elements can be included only if the “Entire 
project” option is used.

- If a Floor Plan is active, the “Visible” option means only the visible 2D elements will be 
saved, and “Selected elements only” means that only the selected 2D elements will be 
saved.

These 2D elements will show up in the IFC scheme structure as IfcAnnotation. Dimensions 
will be exploded into lines and texts, since the IFC2x3 standard documentation does not 
include a dimension element.

During import, all IfcAnnotation-type elements (including exploded dimension elements) of 
the IFC file will be imported into ARCHICAD and converted into 2D elements (texts and lines) 
by checking the box.

• Convert Grid elements

If you check this box, the export process will include the Grid Elements and the grid 
members of the Grid Systems (Design) in the IFC file.

However, the inclusion of grids in the exported file is also affected by the settings of the 
“Export” options in the IFC export dialog boxes. Both in Floor Plan and 3D views, the “Visible” 
option means only the visible grids will be saved, and “Selected elements only” means that 
only the selected grids will be saved.

These grid elements will show up in the IFC structure as IfcGrid.

During import, all IfcGrid elements of the IFC file will be imported into ARCHICAD and 
converted into grouped ARCHICAD Grid Elements by checking the box.
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• Convert 2D symbols of Doors and Windows

If you check this box, the export process will include the 2D symbols of doors and windows 
besides their 3D model geometry. This is handy provided that the recipient program 
recognizes these data and can correctly display, for example, the door opening directions.

During import, all generated doors and windows will be displayed with correct opening 
direction and sizes in floor plan views based on their imported 2D symbols.

Import Options
For import, the following options are editable:

• Show Model Filter on import

If this option is active, then - after you issue an import command - the Model Filter window 
will open.

See Model Filter.

This gives you the chance to overwrite, for the purposes of the current import process, the 
“Import/Export Filter Options” settings of the translator you are using, to fine-tune the 
elements to be imported (e.g. import only certain element types, or just the elements from a 
certain story).

See Import/Export Filter Options.

• Geometry Conversion

Use Conversion Options to define the geometry creation method (and concurrently the type 
of the ARCHICAD element being created) for the following IFC element types:

• Building Elements: IFC elements whose supertype is IfcBuilding (IfcWall, IfcColumn, 
IfcBeam, etc.) can be imported as editable ARCHICAD elements (“Construction elements”: 
Wall, Column, Beam, etc.), or as Morphs or as Objects. Of course, even if you choose the 
“Construction element” option, not all elements can be imported in this form (such as 
non-extruded (BREP geometry) elements, or those elements having no counterpart in 
ARCHICAD): for such elements, you can choose to convert them as either an editable 
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Morph or an Object (“otherwise Objects/otherwise Morphs”). The advantage of 
converting the imported elements to AC tool-based construction elements is that they 
remain parametric, and ARCHICAD functions (such as automatic intersections) will apply 
to them. By choosing to convert elements to Morphs or Objects, you will guarantee 
perfect geometry import. The resulting Morphs will be editable, while the resulting 
Objects will be Library Parts, whose subtype will match the IFC entity type: for example, 
an IfcColumn converted to an ARCHICAD Object will have the subtype “Column”.

• Distribution elements: When importing elements whose domain is MEP 
(IfcDistributionElement), you have three options: generate an object, or generate an 
editable Morph (as described above); or, if GRAPHISOFT MEP Modeler Add-On has been 
installed, then you can generate parametric MEP elements. Even if you choose this latter 
option, however, the MEP IFC model might not contain sufficient data to generate the 
parameters, in which case non-parametric MEP Equipment elements will be generated, 
or - in case of limited data - Objects will be generated.

• Other elements: Elements that are neither building elements nor distribution elements 
(such as furnishing and transportation elements) can be converted to editable Morphs, or 
to Objects.

• IFC Site geometry: Check this box if you want to include the geometry of the imported 
IfcSite. (The option to include or exclude this geometry is available only here, and cannot 
be set in the Model Filter dialog box.) If you opt to include the IFC Site geometry, then you 
can further decide whether the converted element should be an editable Morph or an 
Object. (IfcSite geometry cannot be converted to an ARCHICAD Mesh.)

Notes:

• To optimize the management of shared geometry, ARCHICAD creates as few geometric 
elements (when generating Morphs) or as few Library Parts (when generating Objects) as 
possible.

• Objects can be placed in the project’s Embedded Library, or else saved to a given linked 
library (see IFC Options).

• Some IFC models may contain elements with special geometry which cannot be 
converted to Morphs, even if you choose the Morph conversion option. In this case, 
ARCHICAD will generate Objects, to achieve perfect geometry import.

• Imported IfcSpace elements will always be generated as ARCHICAD Zones, which will 
always retain the imported elements’ original geometry.

• After importing MEP elements to an MEP Modeler environment, you can use the Collision 
Detection function.

• Layer Conversion

Define the method for placing the imported elements onto ARCHICAD layers.

- “Keep original layers” means that ARCHICAD will create new layers that correspond to 
the original layer names (IfcPresentationLayerAssignment) of the IFC model, and will 
place the imported elements onto these layers.

- “Keep original layers and add extension”: This will create new ARCHICAD layers 
corresponding to the original layers of the IFC model, but will add a custom extension 
(such as “Structural Model”) to each of these layer names. The advantage is that, 
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following the file import, you will be able to sort the layers by extension in ARCHICAD’s 
Layer Settings dialog box.

- “Place elements on one layer”: This means that the imported elements will be placed 
onto a newly created, single layer that you define (such as the “IFC Import” layer). In 
this case, the import will delete the original layer names of the IFC model.

Notes:

- The import process automatically sets an intersection group number for all imported 
layers, and this number will be different from the current project layers' intersection 
group number. This difference ensures that the elements on the imported layers will 
not intersect with the existing project elements.

- If the elements have been converted to their counterpart ARCHICAD tool-based 
construction elements (that is, they have not been converted to Objects or Morphs; see 
Geometry Conversion above), then elements on identical layers might have their 
geometries modified due to automatic intersections. If you want to avoid this, set the 
intersection group number to 0.

- If layers of the same name already exist in ARCHICAD, no new layers are created; the 
imported elements are placed onto the corresponding, existing ARCHICAD layers.

- If the import involves element whose geometries are generated by Solid Element 
Operations, then the operator elements are placed on the “IFC Openings” layer, which 
is hidden. If you will move any of the target elements, make sure to show the operator 
elements’ layer and move them together, to avoid modifying the original geometry of 
the imported elements.

• Material and Surface Conversion

Choose one of two methods for importing IFC Materials and defining the representation 
styles of the imported IFC model elements. Both import methods also affect the ARCHICAD 
project’s attributes.

Note: For IFC elements, color is assigned in one of two ways: to its material or to its 
geometry. Color assigned to material is handled by the “Material import method for IFC 
Materials” option and by the material mapping rules; color assigned to geometry is handled 
by the “Generate Surface Attributes from IFC geometry Surface overrides” option.
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Method 1: Create attributes from IFC Materials

This method imports the materials and their colors (if any) assigned to IFC model elements. It 
will create new Building Material attributes, named according to the imported IFC Material 
names. In addition, Surface attributes are created out of any colors assigned to the imported 
IFC Materials. This method ensures that specific materials (e.g. “C20” concrete quality) used 
by the structural engineer in the structural model will be imported, displayed and (as 
needed) listed. The newly created Building Materials will use only data defined in the IFC 
model (name and/or color), while all other Building Material parameters (Cut Fill type and 
orientation, pen settings, Intersection Priority, Categories and Properties data) can be 
defined via mapping rules (see later). In other words, with this method, new attributes are 
created by duplicating a selected Building Material under a new name and (if the IFC 
Material had an assigned color) by adding a new Surface attribute. Of course, if your project 
already contains a Building Material that corresponds in name and color to the imported IFC 
Material, then no new Building Material attribute will be created.

Method 2: Override with Building Materials

Elements will be imported and displayed according to defined mapping rules between IFC 
Materials and Building Materials, which specify a Building Material and an associated 
Surface. With this method, no new attributes are created, and the imported IFC Material’s 
name and representation styles (if any) are not preserved. This override workflow is 
recommended if the goal is to display imported elements using your own defined style 
(rather than the style used to create the IFC model). For example: use the “Steel” Building 
Material (with a red Surface attribute) to display all steel quality IFC Materials, and use the 
“Concrete” Building Material (with a blue Surface attribute) to display all concrete quality IFC 
Materials.
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• Use Material Mapping: Check the Use material mapping box to assign a mapping rule to 
either of these import methods. 

• For Method 1, define the Building Materials which will be duplicated to create the new 
attributes.

• For Method 2, define the Building Materials that will be overridden. The mapping table is 
defined at the “Material Mapping” dialog box: IFC Materials are paired with Building 
Materials available in your project.
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Example: You can assign ARCHICAD’s “Concrete Structural” Building Material to all concrete 
materials entitled “C20” that are imported from a structural IFC model:

• With Method 1: ARCHICAD will create a new Building Material attribute named “C20” (if 
it doesn’t already exist), but the new attribute will use the Cut Fill and Pen settings of the 
existing “Concrete Structural” Building Material.

• With Method 2: ARCHICAD will discard the “C20”IFC Material, and the IFC elements that 
used that material will henceforth use the “Concrete Structural” Building Material with all 
of its display parameters.

You can fill out the IFC Material column of the mapping table by hand, if you know the names 
of the incoming IFC Materials (use the “New” command). Alternatively, you can import this 
data from the IFC model (use the “Merge from IFC” command). In this case, you will be 
prompted to open the IFC file, and once it is opened, the mapping list will contain all the IFC 
Material names that were not yet filled out in the column. Use the list under “ARCHICAD 
Building Material” to pair them. Any IFC Material that has not been paired with an ARCHICAD 
Building Material will be marked with an exclamation point in the second column. Similarly, 
if it has been paired with a Building Material that is not currently available in the project, it 
will be marked with an exclamation point.
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Hints:

• Some of the default translators include predefined mapping rules, whose settings you are 
free to expand or edit. It is recommended to duplicate the default translator before 
modifying it.

• Use the “Merge from IFC” function to fill in the mapping tables of the translators; this 
function will automatically fill in IFC Material names that are not yet in the tables. After 
you complete the mapping table and save the translator, the data will be available the 
next time you import a similar IFC model (e.g. from the same contractor using the same 
program), and you will only need to fill out a few additional IFC Material names, if any.

• You cannot import or export these mapping tables as separate files (e.g. xml); you must 
import/export them together with entire translator file itself (use “Browse” to import).

If the “Use material mapping” option is inactive, then only the “Building Material for non-
mapped materials” setting will take effect:

• With Method 1: the new Building Material attributes will be created by duplicating the 
single Building Material defined here

• With Method 2: All imported IFC elements will be assigned the single Building Material 
defined here, and all elements will be displayed in a uniform style (e.g. with a single color)

The settings described above control the materials and the colors (Surface) assigned to the 
materials. As noted, the IFC element geometries in IFC models can also have an assigned 
color. If an element has both types of color assignments, then the geometry color is of higher 
priority. These colors can be managed with the “Generate Surface Attributes from IFC 
geometry Surface overrides” control:

If the option is on, then ARCHICAD will create Surface attributes using the color assigned to 
the IFC element geometry. These attributes will override the existing settings as follows:

• With Method 1: The geometry color will override the IFC Material’s assigned color
ARCHICAD 20 Help 115



• With Method 2: The geometry color will override the Surface of the Building Material 
being used

To check and modify the resulting surface overrides in ARCHICAD, view the Model panel of 
the respective Element Settings dialog box.

• Renovation Status Conversion

Choose a Renovation Status in ARCHICAD for imported elements that do not have an 
assigned renovation status.

Notes:

• Nearly every model exchange scenario will lack automatic mapping of renovation status. 
The reason is that the IFC2x3 standard has no standard format for renovation status, and 
so the various applications will export this data only as custom IFC properties.

• In model exchange with Revit, the ARCHICAD “Renovation Status” item is mapped to 
Revit’s “Phasing” item, provided that the IFC export and import on the Revit side is 
carried out using the GRAPHISOFT ARCHICAD Connection Add-In.

Export Options
For export, the following options are editable (provided that the translator is not locked).
116 ARCHICAD 20 Help

http://www.graphisoft.com/support/archicad/downloads/interoperability


• Elements to export

Use the element filter for export to configure the current translator.

See Step 3 at Export Functions.

This value determines the default filter used by the export process, but you can still change 
the filter in the export dialog.

Note: If there are selected elements in the project when you start the export, this control 
automatically changes to “Selected elements only”, regardless of the translator’s default 
setting.

• IFC Scheme and Model View Definition

Choose whether you want to save the IFC model according to a version of the widely used 
so-called “Coordination view” IFC2x3 standard, or another (IFC2x3 or IFC4) Model View 
Definition (MVD). If the predefined list does not contain the desired Model View Definition, 
choose “Custom”, and enter the header info required by the MVD in the “Name of custom 
extended view” field.

Note: Depending on the MVD you choose, some of the following “Geometry representation” 
and “Derived model data to export” will not be modifiable. For example, if you are using 
“Coordination View (Surface Geometry)”, the geometry representation of every element is 
required to be BREP. Another example: the “Concept Design BIM 2010” MVD requires the 
export of IFC Type Product element geometries, while the “Coordination View” does not 
allow this. 

See Model View Definitions.

• Properties to export

Use this option to define which property set (IFC Property and Classification Reference) to 
use when saving the model: either all IFC properties available in the IFC Manager, or just the 
IFC properties coming from the current IFC Scheme Setup (seen with the “Show only Scheme 
items” display mode in IFC Manager). Thus, for example, if only the COBie.xml scheme is 
active in the IFC Scheme Setup dialog box, then if you choose “Current Scheme properties 
only”, only data defined as part of the COBie scheme will be saved.

• Geometry conversion
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• Use BREP geometry in current color for all elements: If you would like to export all model 
elements with their precise but non-parametric geometry (i.e. boundary representation), 
activate this option. This option also sets BREP geometry representation for all complex 
elements, elements in Solid Element Operations, elements in junctions, etc. (see later). 
This option also ensures that element bodies will be exported in color displayed in the 
current exporter view, so body colors defined by Criteria-based Visualization (link), 
Renovation Status (link), Revision Status (link) and Mark-Up Style (Correction or Highlight 
color) can be shared with other consultants/applications via IFC exports.

• Triangulate surfaces of BREPs (available only in IFC4 standard code): With this option, the 
BREP geometry is saved as triangulated surfaces - an option preferred by some model 
visualization applications when importing IFC files. This option produces a compact 
geometrical description, which might reduce file size.

• Explode Composite and Complex Profile elements into parts: This will save composite 
elements (e.g. Slab or Wall) and Complex Profiles (e.g. Column, Wall, Beam) as so-called 
“Building Element Parts”. This means that the main element (e.g. IfcWall) will be saved as 
a container element without geometry, and its parts (the skins or profile components) 
will provide the geometry. Use this option to ensure the correct export of the individual 
colors assigned to the Building Materials of each component. This export option retains 
the original colors of all building parts, instead of exporting them in all one color.
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• Export geometries that “Participates in Collision Detection” only: For each Building 
Material, you can define whether it should participate in participate in collision detection 
or not (Options > Element Attributes > Building Materials > Categories and Properties). 
With this export option, you can export composite elements/complex profiles that don’t 
have solid geometries as real air gaps. This way, for example, MEP engineers (who receive 
the ARCHICAD IFC file) can place pipes in the gaps without collision detection, and only 
those element parts having real geometry will participate in collision detection in model-
checkers and in GRAPHISOFT MEP Modeler.
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•  Multi-skin complex geometries: This option will affect multi-skin (Composite or Complex 
Profile) ARCHICAD elements having complex (e.g. slanted) geometry representation.

- Building element parts: An element (e.g. Wall) is logically made into an IFC element 
(e.g. IfcWall) that includes building element parts. The advantage of this option is that 
each building element is assigned the IFC material or profile that is represented by its 
Building Material (Cut Fill) in ARCHICAD.

- Complex profiles: An element is logically made into an IFC element, to which a profile 
geometry or material list will be assigned, in the form of an IFC material. (The receiving 
application will not know the precise order of the different components/skins.)

- Note: This option is affected by the “Partial Structure Display” (Document menu) 
currently in effect, if the view’s visible elements are being exported. For example, if the 
“Core Only” Partial Structure Display is in effect, then the “Complex profiles” option 
will have no effect on a slanted composite wall that has a single core, because in this 
case the wall will not count as a composite element.
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• Elements in Solid Element Operations

- With the extruded/revolved geometry method, elements edited with Solid Element 
Operations will be exported according to their definition geometry - for example, 
without any automatically added intersections. With the BREP method, they will be 
exported as they are displayed in ARCHICAD because of Solid Element Operations.

- Extruded/revolved: This is the standard IFC geometry representation, which retains 
the elements’ parameter values (such as thickness, height, location of reference line or 
edge, skin structure of composite materials) - however, certain specialized sections are 
not retained. This is the format usually supported by static analysis programs, because 
while it is important to retain and possibly to modify the elements’ parameters, their 
special cut angles (such as the slanted edge of a slab) are not important.

- BREP: This method comes closest to reproducing the shape of the element, together 
with its specialized sections and connections. However, the element’s parameters are 
lost, and BREP (Boundary Representation) elements from an imported IFC file are 
transformed into non-editable elements. Since this method provides the most exact 
reproduction of element geometry, it is useful in the “reference model” workflow.
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• Elements with junctions:

- Choose whether to export the elements as either extruded/revolved geometry or with 
BREP. 

- If you prefer the extruded/revolved geometry, you can export the elements without 
junctions - that is, without the priority-based intersections. In this case, the export 
process is faster. This option is recommended for structural analysis programs, for 
which the elements’ reference lines/surface information is sufficient, and detailed 
intersections are not required.

The difference between BREP and extruded/revolved geometry representations is illustrated 
here:

• Slabs with slanted edge(s): With the extruded method, slabs will be exported with 
vertical edges, even though their original geometry included a slanted edge. With the 
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BREP method, such slabs will be exported using their correct original geometric 
representation.

• Use legacy geometric methods as in Coordination View 1.0: Use this option if you have 
created your own, custom MVD that is based on the geometry methods of Coordination 
View version 1.0.

• IFC Site geometry: In ARCHICAD, the IfcSite geometry can be created with Mesh 
elements, with Objects with subtype “Ifc2x_Site” and any modeling element (e.g. Slab, 
Morph) classified (Element Classification) as “Site Geometry”. Depending on whether 
these elements are visible/selected in the view from which you begin the export, and 
depending on your choices at “Export” options, these elements will be exported. Use the 
drop-down list to apply a geometric representation to these elements in the IFC model.

Make your choice depending on which kind of site geometry your partner’s application is 
able to read:

- BREP: Geometric representation as solid bodies enclosed by their superficies and 
boundary surfaces. BREP is a simple form of boundary representation model in which 
all faces are planar and all edges are straight lines.

- Face-based surface (top surface): Geometric representation of the superficies (top 
surface) only.

- Geometric set (wireframe): Geometric representation with contours and points.

Note: ARCHICAD is able to import all three kinds of IFC site geometry representations.
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• IFC Site location (if Survey Point is available): It is recommended to use a common 
anchor/reference point to facilitate coordination of models from different programs (e.g. 
when connecting models submitted by different professionals). In some countries, use of 
a particular reference point (national datum) is a standard requirement when defining 
the project. To define this reference point, use the Survey Point object in ARCHICAD.
The position and rotation of the Survey Point defines the global coordinate system (X=0, 
Y=0, Z=0) of the IFC model. When defining this point position, it is recommended to 
consider the True North direction (use the default “Follow Project North” parameter). At 
IFC export, this parameter defines the direction of the Y axis in the global coordinate 
system.
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Notes:

- In ARCHICAD, True North is defined by Project North (Options > Project Preferences > 
Project Location)

- The Survey Point is always created at IFC Open. In case of Merge IFC, the model is 
imported to be aligned to the host file’s Survey Point.

- Use this translator option to define the location of the IFC Site entity (i.e. its coordinate 
system) at export.

- At Project Origin: The IFC Site entity is located at the Project Origin. Use this option if 
you are working close to the ARCHICAD Project Origin, yet still wish to define model 
coordinates relative to a national datum (using the Survey Point). This way, a far offset 
is stored in the IFC file not as part of the element coordinates but rather generally. See 
the following illustration:
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- At Survey Point position: The IFC Site entity is located at the position of the Survey 
Point. Use this if you are working at a long distance from the Project Origin, yet you 
don’t want large offsets to be present in the IFC file (usually with legacy models). See 
the following illustration:

Notes:

- If the project does not contain a Survey Point, then the IFC model’s global coordinate 
system origin will be the ARCHICAD Project Origin. The IFC Site location will either be at 
the Project Origin too, or - in case of long distances (approximately one-kilometer 
coordinates) - at the Center of Weight of Model calculated by the program. Use this 
option if your earlier models contain elements at long distances (legacy issue). With 
new projects, the Survey Point option is recommended. 

- If the project contains multiple Survey Points (though it is recommended to use just 
one), then the first placed Survey Point will be used. (A warning will alert you to this.)

- The program will consider the Survey Point even if it is not visible in the exported view 
(i.e. if it is on a hidden layer)! Hiding the Survey Point is a good idea anyway, when long 
distances are involved.

• Building Information data to export
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The following options enable you to export additional data in addition to the elements, 
which can be useful for data exchange with facility management, energy analysis or cost 
estimation programs:

Properties and Quantities

• Element Properties: This option exports all ARCHICAD Properties assigned to model 
elements and Zones (defined by Property Manager (Options menu)) as same name IFC 
Properties and grouped in property sets having the name of the container Property 
Groups.

• Element Parameters: This option exports all or only the property-type ("IFC Properties 
only" option) or only the quantity-type ("IFC Quantities only" option) ARCHICAD 
Parameters (including Library Part and Schedule Parameters). The exported IFC Properties 
will keep their source Parameter name and be grouped in Property Sets having the name 
"ARCHICAD Properties" or "(LibraryPartName) Properties"; and the exported IFC 
Quantities will keep their source Parameter name and be grouped in Property Sets having 
the name "ARCHICAD Quantities" or "(LibraryPartName) Quantities". This option can be 
useful when exchanging data with programs that can read such data. For example, 
quantity takeoffs can read quantities; a model viewer/checker can read both properties 
and quantities.

Note: Choosing this option will significantly increase the IFC file size. Thus, use it only if you 
know that the target application can read these data.

• IFC Base Quantities (size, area and volume): Check this box to add Quantity Takeoff 
parameters to Wall (IfcWall), Column (IfcColumn), Beam (IfcBeam), Slab (IfcSlab, 
predefined type Floor), Roof (IfcSlab, predefined type Roof) and Zone (IfcSlab) elements 
to the IFC model. This data is useful in the interoperability with cost estimation 
applications.
For example, the following quantities (IfcElementQuantity) can be exported together with 
IfcWall element: Length; Height; Gross Volume; Net Volume (volume reduced e.g. by 
columns embedded into the wall); Gross Footprint Area (doors are not considered); Net 
Footprint Area (area reduced by door footings); Gross Side Area (openings are not 
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considered); Net Side Area (area reduced by openings).
The following table summarizes the base quantities by entity types automatically 
calculated and exported when using this derived data export option. The values of 
IfcSite’s base quantities can be set manually at Info > Project Info (Site Gross Perimeter 
and Site Gross Area). 

• Window/Door Lining and Panel Parameters: Check this option if you want to export the 
entities listed as IfcWindowStyle and IfcDoorStyle on the IFC Manager’s "Type Products"
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Zone Data

• IFC Space Containment: Space containment defines the relationship between ARCHICAD 
Zones (IfcSpaces) and Furnishing, Mechanical (HVAC) and other contained elements 
defined by Object, Lamp and Morph tools within the space. Check this box if you would 
like to send the model to a facility management application.

Note: Object, Lamp and Morph elements will be in space containment only if the center of 
these elements’ bounding box falls within the ARCHICAD Zone.

Hints:

• Space Containment content can be verified in IFC Manager, by viewing the contents of the 
containment tree in "Space Containment" mode (see IFC Options).

• To export an element as Space Containment that was created with a different tool (e.g. a 
Ceiling element drawn with the Slab tool), you can use the following workaround: change 
the element into a Morph, because the space relation definition will apply to it. (see IFC 
Options).

• IFC Space Boundaries: ARCHICAD Zones include precise geometry data that are useful to 
thermal calculation software applications. Zones are 3D solids in geometrical aspect and 
in normal cases are bordered by two slabs and four walls. Space boundaries define the 
logical connection between ARCHICAD Zones (IfcSpace) and the building elements that 
enclose them. In practice, Walls, Slabs, Roofs, Windows, Doors etc. all have different 
thermal conductivity properties. If you activate the “IFC Space boundaries” option, 
ARCHICAD will export Space boundaries and their relations (IfcRelSpaceBoundary) 
together with the Zones (IfcSpace) to the IFC file. In other words, ARCHICAD will calculate 
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the position, size and adjacency of the elements that border each Zone. ARCHICAD 
divides the Zone boundaries according to the areas defined and cut by connected 
elements and openings.

• Zone Categories as IFC Space Classification Reference: Check this box to export the Zone 
Categories data (Code and Name) of ARCHICAD Zones as their (IfcSpace) IFC Classification 
Reference data (ItemReference and Name).

See Export Functions.

Geometric Data

Bounding Box: Check this box if you would like to export the dimensions of the building 
elements’ bounding box.

Geometry of IFC Type Products: Use this to save the geometry of the various IFC Type 
Product elements. Each type (e.g. IfcFurnishingElementType) will use a representative 
geometry of the elements that belong to it (e.g. IfcFurnishingElement).

• IFC model units

Set the unit type globally for the export of all coordinates, geometric parameters and 
"...Measure"-type IFC Properties (see Custom Data).

Note: When doing an import, the imported elements and data are always displayed using 
ARCHICAD’s model unit preference (Options > Project Preferences).

• IFC Global Unique Identifier attribute (GlobalId)

The “Keep ARCHICAD IFC ID” option means that IFC GlobalId Attributes of elements assigned 
automatically by ARCHICAD will be kept in the exported IFC model. The “Keep ARCHICAD IFC 
ID” option is useful when using other programs to compare two IFC model versions arriving 
from ARCHICAD. The alternative option is “Generate new”. Each new exported IFC file will 
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generate brand new GlobalIds for the elements, so that each new exported version is 
entirely separate from the previous versions.

Note: The IFC Global Unique Identifier attribute (GlobalId) settings option has no effect on 
the Merge to IFC Model export process.
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Model Filter
Each IFC Translator contains defined settings for filtering the elements to be imported or 
exported.

See Import/Export Filter Options.

However, the Model Filter options - which are accessible during the import/export process itself 
- enable you to fine-tune these settings. You can even filter elements one by one from a list. The 
Model Filter function varies depending on whether it is applied during import or export: 

• During export: Model Filter appears in the dialog box of the export command. Based on the 
“Export” settings here (“Selected elements only”, “Visible elements”, etc.), the exportable 
elements are listed: you can now further filter these elements by checking/unchecking their 
boxes.

• During import: The Model Filter can be shown optionally (from Import Options of the 
applied IFC Translator). Model Filter in this case lists all the elements being imported from 
the IFC model, enabling you to further filter them by story or function (e.g. structural or 
HVAC), or one by one.

A tree lists the exportable or importable elements. Use this list to further filter the elements to 
be exported/imported.

Element filtering can be made easier by sorting the list items or grouping them as follows (Group 
elements by):

• IFC Element Type: for example, in case of model import, the IfcWall group contains elements 
exported by an application as IfcWall; and in case of model export, the IfcWall group contains 
ARCHICAD Walls whose classification is set to the default value of “Wall”, as well as all other 
elements that are classified as “Wall”.
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• Story: IFC element types and elements are listed by their story location in the model (e.g. 
Ground Floor).

• Layer: IFC element types and elements are listed by layer.

• Element Owner: element types and elements are listed according to who created them. (In 
ARCHICAD, you can define this person with Project Info (File > Info).)

Further element filtration can be done by IFC Domain (Structural (IfcBuildingElement), HVAC 
(IfcDistributionElement) or customized settings) and/or by Structural Function, as described at 
Translator settings.

See Import/Export Settings.

Note: Filtering by Structural Function works differently for IFC Import and IFC Export: 

• At IFC Import, the filter considers the “LoadBearing” IFC property.

• At IFC Export, the filter considers the ARCHICAD elements’ “Structural Function” 
classification.
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